TraceCompass-10.1.0
Date: 2024/09/11

Section Content LR (o R o T o T o1 -1 I oFeT) 10 VYOV QNI (T BV Te W / ock held by (Tested by) comment of future of tests  Theme
1 Integration | With comments 0
2 JUnitTests | 18
3 TMF - Project View | With comments 106
4 TMF - Events Editor | With comments 11 Table
5 TMF - Bookmarks View ‘ 17 Config
6  TMF - Filters View | With comments 12 Config
7 TMF - Colors View | With comments 6 Config
8  TMF - Histogram View | With comments 6 XY-ish
9  TMF - Statistics View 7 Table
10  TMF - Remote Fetching ‘ 51 Tracer Control
11 GDB Tracing | With comments 15 Tracer Control
12 TMF - Sequence Diagram | With comments 22 Tracer Control
13 TMF - Custom Parsers ‘ 12 Tracer Control
14 LTTng 2.0 - Control View | With comments 115 Config
15 XML Analysis | With comments 10 Config
16 Trace Synchronization ‘ 0 Config
17 TMF - Time Chart View | With comments 1 Gantt-ish
18  TMF - State System Explorer ‘ 6 Gantt
19 TMF - Flame Chart View | With comments 14 Gantt
20  LTTng 2.0 - Control Flow View ‘ 22 Gantt
21 LTTng 2.0 - Resources View | With comments 16 Gantt
22 Critical Path | With comments 42 Gantt
23 Flame Graph View 11 Gantt
24 LTTng 2.0 - Memory Analysis ‘ 8 XY
25  LTTng 2.0 - CPU Analysis | With comments 13 XY
26 Network Trace Analysis | With comments 3 XY
27 LTTng 2.0 - I/O Analysis 6 XY
28  Counters View ‘ 0 XY
29  LAMI | With comments 0 Untestested Reports




30 Tracing RCP [0 54 IO 34 with comments[ 0|
Total: [ 52 [ 982 | 0 [1034] Remaining: 11%

New Bug Reports found Open Fixed Total
Bug Reports 11 5 16




Section # Bug Reports # Open # Fixed

Bug Reports 17 11 5
Test Case Bug Title Bug Report Status
Drag and Drop from other Tracing project tmf: java.lang.Error: SWT Resource was not properly disposed for TmfPieChart when closing trace  https://bugs.eclipse.org/bugs/show_bug.cgi?id=576612 Open
Delete propagation Deleting last trace from Experiment also deletes that experiment https://bugs.eclipse.org/bugs/show_bug.cgi?id=579305 |Fixed Not a bug
Overwrite Yes-To-All in Trace Package Import wizard prompts again (behaves like Yes) https://bugs.eclipse.org/bugs/show_bug.cgi?id=579323 Open
Set invalid window span [TMF] Entering a window span of 1ns in Histogram View should be invalid https://bugs.eclipse.org/bugs/show_bug.cgi?id=550946 Open
Mouse synchronization (single time) Left-clicking on time chart first doesn't sync in editor and other views https://bugs.eclipse.org/bugs/show_bug.cgi?id=579357 |Fixed Not a bug
Filter cleared Clearing filter from editor doesn't update time chart view https://bugs.eclipse.org/bugs/show_bug.cgi?id=579358 |Fixed
Select Event using arrow keys (457852) [TMF] Event table raw viewer selection not propagated to Properties view https://bugs.eclipse.org/bugs/show_bug.cgi?id=457852 None Fixed?
Open Experiment Flame Graph symbol resolution does not work with experiment https://bugs.eclipse.org/bugs/show_bug.cgi?id=512462 Open
Delete analysis [lami] Remove External Analysis does not refresh properly https://bugs.eclipse.org/bugs/show_bug.cgi?id=543800 Open
Actions unavailable [lami]: It is not possible to know why an analysis cannot be executed https://bugs.eclipse.org/bugs/show_bug.cgi?id=498218 |Fixed
Deselection [lami] Selecting an already selected bar in chart doesn't unselect it from chart or table https://bugs.eclipse.org/bugs/show_bug.cgi?id=579392 Open Deselection (other test)
Test page navigation, Test menu item 'Pages...' [Sequence Diagram] Go to {next,previous} page does not update SD view https://bugs.eclipse.org/bugs/show_bug.cgi?id=581103 [Fixed Notabug  (cf. Bernd)
Find short-cut [Sequence Diagram] Multiple Find dialogs can be opened simultaneously https://bugs.eclipse.org/bugs/show_bug.cgi?id=581104 Open
Show node {end,start} short-cut [Sequence Diagram] Shift-Alt-{home,end} does not work if hovering over selected int https://bugs.eclipse.org/bugs/show_bug.cgi?id=581105 Open
Overview feature [TMF] Sequence Diagram Overview feature not working well on recent platform versions https://bugs.eclipse.org/bugs/show_bug.cgi?id=436442 Open
Print [Sequence Diagram] Print dialog does not update Preview upon Print range changes https://bugs.eclipse.org/bugs/show_bug.cgi?id=581106 Open

Open crossed out analysis [lami] NotEnabledException when trying to open an analysis that is crossed out https://bugs.eclipse.org/bugs/show_bug.cgi?id=581950 | Open



https://bugs.eclipse.org/bugs/show_bug.cgi?id=576612
https://bugs.eclipse.org/bugs/show_bug.cgi?id=579305
https://bugs.eclipse.org/bugs/show_bug.cgi?id=579323
https://bugs.eclipse.org/bugs/show_bug.cgi?id=550946
https://bugs.eclipse.org/bugs/show_bug.cgi?id=579357
https://bugs.eclipse.org/bugs/show_bug.cgi?id=579358
https://bugs.eclipse.org/bugs/show_bug.cgi?id=457852
https://bugs.eclipse.org/bugs/show_bug.cgi?id=512462
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https://bugs.eclipse.org/bugs/show_bug.cgi?id=498218
https://bugs.eclipse.org/bugs/show_bug.cgi?id=579392
https://bugs.eclipse.org/bugs/show_bug.cgi?id=581103
https://bugs.eclipse.org/bugs/show_bug.cgi?id=581104
https://bugs.eclipse.org/bugs/show_bug.cgi?id=581105
https://bugs.eclipse.org/bugs/show_bug.cgi?id=436442
https://bugs.eclipse.org/bugs/show_bug.cgi?id=581106
https://bugs.eclipse.org/bugs/show_bug.cgi?id=581950

Section
Integration

Target: Ubuntu 20.04.5 64-bit

Step Test Case

1
1.1

1.2
1.3
14
1.5
1.6

1.7

N
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22
23
24
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26

2.7

w

3.1

3.2

3.3

34

3.5

Y

4.1

4.2

EPP: Eclipse Packaging Project
Verify C/C++ EPP Package RC1

Download EPP Package

Version of Tracing Features

GDB Tracepoint Analysis presence
LTTng presence

OS Tracing presence

TMF presence

2022-12 Update Site (e.g.)
Verify C/C++ EPP Package RC2

Download EPP Package

Version of Tracing Features

GDB Tracepoint Analysis presence
LTTng presence

OS Tracing presence

TMF presence

2022-12 Update Site (e.g.)
Verify Update Site

2024-06 Update Site (e.g.)

Trace Compass Update Site

Upgrade using 2024-06 (e.g.) Update Site

Upgrade using Trace Compass Update Site

Upgrade from previous EPP
Verify Update Site

Trace Compass update site

Upgrade using Trace Compass update site

Pass

Download, extract and start EPP package. Check the mailing list for the package:
https://dev.eclipse.org/mailman/listinfo/epp-dev

Go to Help -> About Eclipse IDE -> Installation Details
Open GDB Trace perspective

Open LTTng Kernel perspective

Open OS Tracing Overview perspective

Open Tracing perspective

Go to Help -> Install New Software... -> Update site "2024-06 - https://download.eclipse.
org/releases/2024-06/", Unselect "Hide items that are already installed"

Download, extract and start EPP package. Check the mailing list for the package:
https://dev.eclipse.org/mailman/listinfo/epp-dev

Go to Help -> About Eclipse IDE -> Installation Details
Open GDB Trace perspective

Open LTTng Kernel perspective

Open OS Tracing Overview perspective

Open Tracing perspective

Go to Help -> Install New Software... -> Update site, select "2024-06 - https://download.eclipse.

org/releases/2024-06/", Unselect "Hide items that are already installed"

Download Eclipse for Committers and install LTTng Kernel, LTTng UST, GDBTrace and PCAP

Network Analysis from main simrel testing Update site
"2024-09 - http:/download.eclipse.org/releases/2024-09/"

Download Eclipse for Committers and install LTTng Kernel, LTTng Control, LTTng UST, GDBTrace

and PCAP Network Analysis from the Trace Compass Update site http:/download.eclipse.
org/tracecompass/2024-09/milestones/rc2

Download Eclipse for Committers from 2024-06 and install LTTng, LTTng Kernel, GDBTrace and
PCAP Network Analysis from main simrel Update site. http://download.eclipse.org/releases/2024-06

Try to update the installation using the testing simrel update site.
https://download.eclipse.org/releases/2024-09/

Download Eclipse for Committers from 2024-06 and install LTTng, LTTng Kernel, LTTng UST,

GDBTrace and PCAP Network Analysis from the Trace Compass release Update site.
http://download.eclipse.org/tracecompass/releases/10.0.0/repository

Try to update the installation using the Trace Compass update site http://download.eclipse.
org/tracecompass/2024-09/milestones/rc2

Download Eclipse previous C/C++ EPP package (2024-06). Try to upgrade using both update sites:

"https://download.eclipse.org/releases/2024-09"
The information about the update sites to use is usually posted on epp-dev:
https://dev.eclipse.org/mailman/listinfo/epp-dev

Release outside release train

Download Eclipse standard and install LTTng Kernel, LTTng Control, LTTng UST, GDBTrace and

PCAP Network Analysis from main

Update site: http://download.eclipse.org/tracecompass/stable/repository/ and http://download.eclipse.

org/tracecompass/r 10.0.0/repository/

Download Eclipse standard and install LTTng Kernel, LTTng Control, LTTng UST, GDBTrace and

PCAP Network Analysis from the Trace Compass update site:
https://download.eclipse.org/tracecompass/stable/repository/ and http://download.eclipse.
org/tracecompass/rel 10.0.0/repository/

Fail

Verification

EPP Package starts

Verify that all tracing features and plug-ins are
present and have the correct version (TMF,
LTTng, CTF, GDBTrace)

GDB Trace perspective opens

LTTng Kernel perspective opens

OS Tracing Overview perspective opens
Tracing perspective opens

Verify that all LTTng Kernel, LTTng UST and
GDB Trace are available

EPP Package starts

Verify that all tracing features and plug-ins are
present and have the correct version (TMF,
LTTng, CTF, GDBTrace)

GDB Trace perspective opens
LTTng Kernel perspective opens
OS Tracing Overview perspective opens

Tracing perspective opens
Verify that all LTTng Kernel, LTTng UST and
GDB Trace are available

Verify that installation was successful

Verify that installation was successful

Verify that installation was successful

Verify that installation was successful

Verify that installation was successful

Verify that installation was successful

Verify that installation was successful

Automated
0

To Do Comments
0 5

Manual

Manual
Manual
Manual
Manual
Manual

Manual

Manual

Manual
Manual
Manual
Manual
Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Comment

Tested with RC2

Tested with RC2

Tested with RC2

Tested with RC2

N/A

N/A

Must also select 'LTTng Tracer Control' to upgrade, which
requires unchecking 'Group items by category'.


https://www.eclipse.org/downloads/packages/

Section Automated To Do Comments
JUnit Tests

Target: Ubuntu 12.04 64 bit and on Hudson

Step Test Case Action Verification Type Comment
1 Junit Test Cases
1.1 CTF Core Tests Plug-in Run manually or with Jenkins All test cases To Doed Unit Pass
1.2  CTF Parser Tests Plug-in Run manually or with Jenkins All test cases To Doed Unit Pass
1.3  State System Core Tests Plug-in Run manually or with Jenkins All test cases To Doed Unit Pass
1.4  TMF Core Tests Plug-in Run manually or with Jenkins All test cases To Doed Unit Pass
1.5 TMF Ul Tests Plug-in Run manually or with Jenkins All test cases To Doed Unit Pass
1.6 TMF Ul SWTBot Tests Plug-in Run manually or with Jenkins All test cases To Doed Unit Pass
1.7  CTF Support for TMF SWTBot Tests Plug-in Run manually or with Jenkins All test cases To Doed Unit Pass
1.8  TMF Xml Analysis Core Tests Plug-in Run manually or with Jenkins All test cases To Doed Unit Pass
1.9  TMF Xml Analysis Ul Tests Plug-in Run manually or with Jenkins All test cases To Doed Unit Pass
1.10 LTTng Control Core Tests Plug-in Run manually or with Jenkins All test cases To Doed Unit Pass
1.11  LTTng Control Ul Tests Plug-in Run manually or with Jenkins All test cases To Doed Unit Pass
1.12 LTTng Kernel Analysis Core Tests Plug-in Run manually or with Jenkins All test cases To Doed Unit Pass
1.13 LTTng Kernel Analysis Ul Tests Plug-in Run manually or with Jenkins All test cases To Doed Unit Pass
1.14 LTTng Kernel Ul SWTBot Tests Plug-in Run manually or with Jenkins All test cases To Doed Unit Pass
1.15 LTTng Userspace Tracer Analysis Core Test Plug-in  Run manually or with Jenkins All test cases To Doed Unit Pass
1.16 LTTng Userspace Tracer Analysis Ul Test Plug-in Run manually or with Jenkins All test cases To Doed Unit Pass
1.17 GDB Tracepoint Analysis Core Tests Plug-in Run manually or with Jenkins All test cases To Doed Unit Pass
1.18 GDB Tracepoint Analysis Ul Tests Plug-in Run manually or with Jenkins All test cases To Doed Unit Pass




Section
TMF - Events Editor

Target: Windows

Step Test Case

1
1.1

N

w

IS

4.3
44
4.5

(3,

Preparation

Preparation step 1
Trace bookmarks
Experiment bookmarks

Filter

Filter

Cancel filter

Un-filter

Filter & Search

Search & Filter

Time Synchronization
Mouse synchronization
Key synchronization
Search synchronization
External synchronization

Range selection

Event Synchronization

Open trace

Mouse synchronization

Key synchronization

Search synchronization

External synchronization

Source Code / Model Lookup

Pass

Action

Open and reset LTTng Kernel perspective
Moved to sheet "BookmarksView"

Moved to sheet "BookmarksView"

In the header row, enter some regex and press Ctrl+Enter

Fail

Verification

LTTng Kernel perspective opens with correct views.

Only events matching regex are displayed. Top and bottom filter status
rows update while filtering is ongoing. When filtering is done, status
rows show number of matching events.

In the header row, enter some regex and press Ctrl+Enter, then Only some events matching regex are displayed. Status rows show

quickly press ESC before filtering is done

In the header bar, click the icon to delete a filter
In the filter bar, enter some regex; likewise in the search bar
In the search bar, enter some regex; likewise in the filter bar

Select any event in the table with the mouse button

Select any event in the table using Up, Down, PageUp,
PageDown, Home, End

In the search bar, enter some regex, then search again with
Enter/Shift-Enter

In any other view that supports time synchronization, select a
time.

Select an event with left button, press shift key and click to
select another event

Open an LTTng CTF Kernel trace

Select any event in the table with the mouse button

Select any event in the table using Up, Down, PageUp,
PageDown, Home, End

In the search bar, enter some regex, then search again with
Enter/Shift-Enter

In any other view that supports time synchronization, select a
time. The selected event in the editor is updated. Then give

focus back to the editor. Make sure the events table is clicked.

partial number of matching events, with different 'stop' icon.

All events are displayed. Selected event remains selected and visible.
Status rows are removed.

Events are filtered and highlighted accordingly

Events are filtered and highlighted accordingly

Other views are synchronized to the selected event's time
Other views are synchronized to the selected event's time
Other views are synchronized to the selected event's time
The first event at or following the selected time is selected and visible.

Range of events are highlighted. Selection range is updated in other
views that support range selection

Verify that an editor is opened showing LTTng Kernel specific columns.

Views are updated with the new trace.

The Properties view is updated with the selected event's Property and
Value. Timestamp and Content are expandable.

The Properties view is updated with the selected event's Property and
Value. Timestamp and Content are expandable.

The Properties view is updated with the selected event's Property and
Value. Timestamp and Content are expandable.

The Properties view is updated with the selected event's Property and
Value. Timestamp and Content are expandable.

Automated To Do Comments

Type

SWTBot Pass

SWTBot
Manual
SWTBot

SWTBot
SWTBot

Manual

Manual

Manual

Manual

Manual

SWTBot

Manual

Manual

Manual

Manual

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

5

Comment

Histogram and Properties.

Histogram and Properties.

Histogram and Properties.

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate



71

7.2

7.3

8.1

8.2

8.3

9.1

8.2

8.3

Preparation

Open call site

Open call site (no source code)

Export to text

Export CTF trace

Export Other Trace

Copy to clipboard

Swap Columns and Change Fonts

Swap columns in events table

Change fonts

Reset fonts

1) Download traces.zip (if necessary) and unzip into a local

directory ${local}

2) Unzip traces/c_project_callsite.zip and traces/callsite.zip

to your local disk.

3) Import demo C project to the Eclipse workspace of zip

file c_project_callsite.zip

4) Import the test trace of zip file callsite.zip to a tracing

project.

5) Select trace type "Generic CTF Trace" and open the

trace.

MAKE SURE THE FILES ARE IN THE SAME LOCATION

1) select event in table

2) click right mouse button

3) select "Open Source Code" menu item
1) Close source code project

2) select event in table

3) click right mouse button

4) select "Open Source Code" menu item

1) Open a CTF trace (e.g. LTTng Kernel)
2) Click right mouse button

3) Select "Export To Text" menu item

4) Enter a file name and location

5) Press OK

Progress bar is the eclipse one in the bottom.

1) Open a trace other than CTF trace
2) Click right mouse button

3) Select "Export To Text" menu item

4) Enter a file name and location

5) Press OK

1) Open a CTF trace (e.g. LTTng Kernel)
2) Click right mouse button

3) Select "Copy to Clipboard" menu item
4) Paste it in a text file

1) Open a trace

2) Drag a column

1) Open the preferences

2) select new font for trace types
3) press apply

4) verify that the font changed

1) Open the preferences

2) Reset the font settings

3) Press apply

4) verify that the font changed

Zip file(s) available under
https://drive.google.com/drive/folders/1DJ2FSYWi1u8HHfi2HWCtoAOKc

Verify that correct source code file and line number is opened

Since the source code is not available no source code file is opened.
Instead an error dialog is opened (with title "FileNotFoundException")

Make sure that a progress monitor dialog is opened during the export.
After finishing make sure that the text file exists and it contains the
events stored in the file. Verify that the columns are printed as shown
in the events table and that they are separated by tab character.

Make sure that a progress monitor dialog is opened during the export.
After finishing make sure that the text file exists and it contains the
events stored in the file. Verify that the columns are printed as shown
in the events table and that they are separated by tab character.

Verify that the columns are printed as shown in the events table and

that they are separated by tab character.

Covered by SWTBot tests

Covered by SWTBot tests

Covered by SWTBot tests

Manual

Manual

Manual

SWTBot

Manual

SWTBot

SWTBot

SWTBot

SWTBot

https://cdn.vector.
BTF_Specificai f



https://cdn.vector.com/cms/content/products/TA_Tool_Suite/Docs/BTF_Specification.pdf
https://cdn.vector.com/cms/content/products/TA_Tool_Suite/Docs/BTF_Specification.pdf
https://cdn.vector.com/cms/content/products/TA_Tool_Suite/Docs/BTF_Specification.pdf

Section Pass Fail Automated To Do Comments
TMF - Project View 152 | 106 | o o
Target: Ubuntu 20.04.5 LTS 64-bit

Step Test Case Action Verification Type Comment

1 Preparation

1.1 Step 1 Open LTTng Kernel perspective LTTng perspective opens with correct views SWTBot Pass
12 Step2 Open Project Explorer Project Explorer opens SWTBot .m
2 Project Creation
2.1 New Project Wizard Open New Tracing Project Wizard Tracing Project Wizard opens SWTBot Pass
2.2 Create project Specify a project name and finish Tracing project appears in Project Explorer SWTBot Pass
2.3  Project structure Open the new Tracing project Project contains Experiments and Traces SWTBot Pass
3 Traces Folder

1) Download traces.zip (if necessary) and unzip into a
local directory ${local}
2) Import Custom Text and XML parsers

ustomX| ar: xml.
ExampleCustomTxtParser.xml) from directory
traces/customParsers into your workspace from the

Preparation Manage Custom Parsers dialog. SWTBot Pass
3.1 Traces Folder menu Select the Traces folder and open its context menu Correct menu opens (Import, Refresh) SWTBot Pass
3.2  Trace Import Wizard Select Import Trace Import Wizard appears SWTBot Pass

1) Browse to directory ${local}/traces/import/
2) Select trace ExampleCustomTxt.log
3) Keep <Auto Detection>, Select "Import unrecognized

traces", unselect "Overwrite existing without warning" and Imported trace appear in Traces Folder and the
Import single custom text trace select "Create Links to workspace" and Trace Type Tmf Generic is set. Make sure
3.3 (link to workspace) 4) press Finish trace can be opened SWTBot Pass
Imported trace appear in Traces Folder and the
Import Single custom XML trace Trace Type "Custom XML log" is set. Make
3.4  (link to workspace) redo 3.1-3.3 but this time select ExampleCustomXml.xml sure that trace can be opened SWTBot Pass
Imported trace appear in Traces Folder and the
Import LTTng Kernel CTF trace redo 3.1-3.3 but this time select directory kernel-overlap- Trace Type "LTTng Kernel" is set. Make sure
3.5  (link to workspace) testing/ that trace can be opened SWTBot Pass
redo 3.3, 3.4, 3.5. However, Unselect "Create Links to
workspace" Traces are imported with new name that has a
suffix (2) at the end. Make sure that imported
3.6 Rename + copy import When dialog box appear select Rename traces are copied to the project. SWTBot Pass
redo 3.3, 3.4, 3.5. However, Unselect "Create Links to
workspace" Existing traces are deleted and new traces are
imported. Make sure that imported traces are
3.7 Overwrite + copy import When dialog box appear select Overwrite copied to the project and can be opened SWTBot Pass
redo 3.3, 3.4, 3.5. However, Unselect "Create Links to
workspace"
3.8  Skip When dialog box appear select Skip Make sure that no new trace is imported SWTBot Pass
Make sure that no dialog box appears (for
redo 3.3, 3.4, 3.5. However, Unselect "Create Links to renaming, overwriting, skipping) and existing
3.9 Default overwrite workspace" and select "Overwrite existing without warning”  traces are overwritten). Make sure trace can be  gwTBot Pass
1) Open Import wizard (see 3.1-3.2)
2) Browse to directory ${local}/traces/import
3) Select trace unrecognized.log
4) Keep <Auto Detection>, Select "Import unrecognized unrecognized.log is imported with trace type
traces", unselect "Overwrite existing without warning" and unknown. The default text file icon is displayed.
select "Create Links to workspace" and The file, not trace, when opened, is displayed
3.10  Import unrecognized 5) press Finish in the text editor. SWTBot Pass
redo 3.10, however unselect "Import unrecognized traces"
3.11  Import unrecognized (ignore) unrecognized.log is not imported SWTBot Pass
Delete all traces in project - Right mouse click on Traces
Preparation folder and select "Clear" SWTBot Pass
Imported trace appear in Traces Folder and the
Import CTF trace by selection Redo 3.5, However only select metadata file instead of Trace Type "LTTng Kernel" is set. Make sure
3.12 metadata file only directory trace that trace can be opened SWTBot Pass

Preparation Delete all traces in project



3.13

3.14

3.15

3.16

3.17

3.18

3.19

Recursive import with auto-
detection (Rename All)
Preparation

Recursive import with auto-
detection (Overwrite All)
Preparation

Recursive import with auto-
detection (Skip All)
Preparation

Recursive import with auto-
detection (test rename, overwrite
and skip)

Preparation

Recursive import with specific
trace type 1 (Skip All)
Preparation

Recursive import with specific
trace type 2 (Skip All)
Preparation

Recursive import with specific
trace type 3 (Skip All)
Preparation

1) Open Import wizard (see 3.1-3.2)
2) Browse to directory ${local}/traces/import
3) select directory import

4) Keep <Auto Detection>, Select "Import unrecognized
traces", unselect "Overwrite existing without warning", select
"Create Links to workspace" and unselect "Preserve Folder

Structure”

5) press Finish

6) When dialog appears select "Rename All"
Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/
3) select directory import

4) Keep <Auto Detection>, Select "Import unrecognized
traces", unselect "Overwrite existing without warning", select
"Create Links to workspace" and unselect "Preserve Folder

Structure”

5) press Finish

6) When dialog appears select Overwrite All"
Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/
3) select directory import

4) Keep <Auto Detection>, Select "Import unrecognized
traces", unselect "Overwrite existing without warning" and
select "Create Links to workspace" and uncheck "preserve

folder structure”

5) press Finish

6) When dialog appears select Skip All"
Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/
3) select directory import

4) Keep <Auto Detection>, Select "Import unrecognized
traces", unselect "Overwrite existing without warning", select
"Create Links to workspace" and unselect "Preserve Folder

Structure”

5) press Finish

6) When dialog appears select "Rename”

7) When dialog appears select "Overwrite"
8) When dialog appears select "Skip"
Delete all traces in project

1) Open Import wizard

2) Browse to directory ${local}/traces/import/
3) select directory import

4) Select trace type "Generic CTF Trace", Select "Import
unrecognized traces”, unselect "Overwrite existing without
warning", select "Create Links to workspace" and unselect

"Preserve Folder Structure"and

5) press Finish

6) When dialog appears select Skip All"
Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/
3) select directory import

4) Select trace type "LTTng Kernel Trace", Select "Import
unrecognized traces”, unselect "Overwrite existing without
warning", select "Create Links to workspace" and unselect

"Preserve Folder Structure”

5) press Finish

6) When dialog appears select Skip All"
Delete all traces in project

1) Open Import wizard

2) Browse to directory ${local}/traces/import/
3) select directory import

4) Select trace type "LTTng UST Trace", Select "Import
unrecognized traces”, unselect "Overwrite existing without
warning", select "Create Links to workspace" and unselect

"Preserve Folder Structure”

5) press Finish

6) When dialog appears select Skip All"
Delete all traces in project

All Traces are imported with respective trace
type set. Traces with name clashes are
imported with suffix (2). 1 trace (unrecognized.
log) is imported with trace type unknown. Make
sure that traces can be opened which have a
trace type set. The unknown trace type should
open with the text editor.

All Traces are imported with respective trace
type set. Traces with name clashes are
overwritten . 1 trace (unrecognized.log) is
imported with trace type unknown. Make sure
that traces can be opened which have a trace
type set. The unknown trace type should open
with the text editor.

All Traces are imported with respective trace
type set. Traces with name clashes are not
imported. 1 trace (unrecognized.log) is
imported with trace type unknown. The
unknown trace type should open with the text
editor.

All Traces are imported with respective trace
type set. Traces with name clashes are either
renamed, overwritten or skipped as per dialog
action. Make sure that traces can be opened
which have trace type set. The unknown trace
type should open with the text editor.

After selecting trace type, verify that button
"Import unrecognized traces" is disabled.

4 CTF traces are imported with trace type
"Generic CTF Trace" . Make sure that these
traces can be opened

After selecting trace type, verify that button
"Import unrecognized traces" is disabled.

One LTTng Kernel trace is imported with trace
type "LTTng Kernel Trace". Make sure that this
trace can be opened.

After selecting trace type, verify that button
"Import unrecognized traces" is disabled.

3 LTTng UST traces are imported with trace
type "LTTng UST Trace". Make sure that these
traces can be opened.
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3.20

3.21

3.22

3.23

3.24

3.25

3.26

3.27
3.28

3.29

3.30

3.31

3.32

3.33

3.34

Recursive import with specific
trace type 4 (Skip All)
Preparation

Import wizard from workbench
menu with project selected
Import wizard from workbench
menu with no project selected
Preparation

Drag and Drop from other Tracing
project

Drag and Drop from non-Tracing
project

Drag and Drop from external

Drag and Drop of trace with
existing name

Drag and Drop of trace with
existing name (2nd time)
Import destination
Preparation

Recursive import with preserved
folder structure

Recursive import with preserved
folder structure (Skip All)

Recursive import with preserved
folder structure (Rename All)
Preparation

Delete with mixed selection of

traces and folders

Delete multiple folders

Clear single Traces folder

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Select trace type "Tmf Generic", Select "Import

unrecognized traces”, unselect "Overwrite existing without
warning", select "Create Links to workspace" and unselect

"Preserve Folder Structure”

5) press Finish

6) When dialog appears select Skip All"
Delete all traces in project

1) Select project "Test" in Project Explorer view

2) Open import wizard from menu File > Import... > Tracing >

1) Clear selection in Project Explorer view

2) Open import wizard from menu File > Import... > Tracing >

Delete all traces in project

D&D a few LTTng traces from another Tracing project's

Traces folder

D&D a few files from a non-Tracing project, if a CTF trace,

will need to drag the entire folder

D&D a few files from an external file manager

1) D&D a trace with name of an existing trace into traces

folder
2) Confirm the renaming of traces

Redo test 3.26 with the same trace and same destination

folder

Open Import wizard

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/
3) select directory import

4) Select trace type "Tmf Generic", unselect "Overwrite
existing without warning", select "Create Links to workspace'

and select "Preserve Folder Structure”
5) press Finish

1) Open Import wizard (see 3.1-3.2)
2) Browse to directory ${local}/traces/import/
3) select directory import

4) Select trace type "Tmf Generic", unselect "Overwrite
existing without warning", select "Create Links to workspace'

and select "Preserve Folder Structure"
5) press Finish
6) When dialog appears select "Skip All"

1) Open Import wizard (see 3.1-3.2)
2) Browse to directory ${local}/traces/import/
3) select directory import

4) Select trace type "Tmf Generic", unselect "Overwrite
existing without warning", select "Create Links to workspace'

and select "Preserve Folder Structure”

5) press Finish

6) When dialog appears select "Rename All"
Delete all traces in project

1) Create two trace folders under the "Traces" folder

2) Import 2 traces under each folder
3) Open all 4 traces

4) Select one trace in the first folder and the second folder in

the Project Explorer view
5) Right-click, Delete. Click Yes.

1) Create 2 trace folders under the "Traces" folder

2) Import a trace under each folder

3) Open both traces

4) Select both folders in the Project Explorer view
5) Right-click, Delete. Click Yes

1) Import 2 traces from different folders preserving folder

structure

2 Open both traces.

3 Select the Traces folder

4) Right-click, Clear. Click Yes.

Al text files in directories are imported as trace
and trace type "Tmf Generic" is set. Note that
trace type validation only checks for file exists
and that file is not a directory. Make sure that
these traces can be opened. However traces
with wrong trace type won't show any events in
the table.

Verify that trace is imported to "Test" project
and can be opened.

Verify that trace is imported to default "Tracing"
project and can be opened.

Selected traces are added to Traces folder with
proper icon. Trace can be opened.

Selected traces are added to the Traces folder
with default icon. Files can be opened with the
default editor.

Selected traces are added to the Traces folder
with default icon. For actual traces, Trace type
is detected automatically. Trace can be
opened. For non traces the files are added with
default icon and they can be opened with the
default editor.

Verify that trace is added into the traces folder
with the trace name of the original trace plus a
suffix (2)

Verify that trace is added into the traces folder
with the trace name of the original trace plus a
suffix (3)

Verify "Into Folder" box cannot be updated

All Traces are imported with respective trace
type set. The folder "clashes" is imported with
its traces inside. Make sure that traces can be
opened which have a trace type set.

The wizard should finish quickly as no trace will
be imported. Make sure that traces can be
opened which have a trace type set.

All Traces are imported with respective trace
type set with suffix (2). The folder "clashes" is
imported with its traces inside. Make sure that
traces can be opened which have a trace type
set.

A dialog should ask the user to confirm
deletion of the selected elements. Clicking OK
should remove all that was selected. The editor
of the 3 deleted traces should be closed
automatically with one remaining editor
opened.

A dialog should ask the user to confirm
deletion of the selected elements. Clicking OK
should remove all that was selected. The editor
of both traces should be closed automatically.

A dialog should ask the user to confirm
clearing of the folder. Clicking Yes should
remove everything under the selected folder
and close the traces
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eclipse. bug.cgi?id=576612

Dropping a folder linking to existing kernel trace one from generic project.

When dragging under Tracing project root, icons look like defaults.

When dragging under Traces folder, icons and Views become standard tracing ones.

Similar to above.

Sehr: Not sure which import method this is using, it passes for Trace Import, but not other file imports


https://bugs.eclipse.org/bugs/show_bug.cgi?id=576612

3.35

3.36

3.37

3.38

3.39

3.40

3.41

4.1
4.2
4.3
4.4
4.5
4.6
4.7
4.8
4.9

5.1
52

6.1
6.2
6.3
6.4
6.5
6.6
6.7
6.8

Clear multiple Traces folder

Preparation

Import from zip archive, preserve
folder structure

Preparation

Import from zip archive, no
preserve folder structure

Preparation

Import from zip archive specific
traces

Preparation

Import from tar.gz archive,
preserve folder structure

Preparation

Import from tar.gz archive, no
preserve folder structure

Preparation

Import from tar.gz archive specific
traces

Trace

Trace menu

Open trace

Copy trace

Rename trace

Delete trace

Open Trace (Accelerator)
Delete Trace (Accelerator)
Open Trace (double click)
Open Trace (already open)

Experiments Folder

Experiments menu
Create experiment

Experiment

Experiment menu

Select Traces dialog

Select traces

Open experiment

Copy experiment

Rename experiment

Delete experiment

Open Experiment (Accelerator)

1) Import 2 traces to different projects

2 Open both traces.

3 Select both Traces folders

4) Right-click, Clear. Click Yes.

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Select archive file: traces.zip

3) select directory the root directory

4) Select trace type "Automatic”, unselect "Overwrite existing
without warning” and select "Preserve Folder Structure”

5) press Finish

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Select archive file: traces.zip

3) select directory the root directory

4) Select trace type "Automatic”, unselect "Overwrite existing
without warning” and unselect "Preserve Folder Structure”
5) press Finish

6) Select Rename All when dialog comes up.

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Select archive file: traces.zip

3) select file "z-clashes/ExampleCustomTxt.txt" and folder
"kernel-overlap-testing”

4) Select trace type "Automatic”, and select "Preserve Folder
Structure”

5) press Finish

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Select archive file: traces.tar.gz

3) select directory the root directory

4) Select trace type "Automatic”, unselect "Overwrite existing
without warning" and select "Preserve Folder Structure"

5) press Finish

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Select archive file: traces.tar.gz

3) select directory the root directory

4) Select trace type "Automatic”, unselect "Overwrite existing
without warning" and unselect "Preserve Folder Structure”
5) press Finish

6) Select Rename All when dialog comes up.

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Select archive file: traces.tar.gz

3) select file "z-clashes/ExampleCustomTxt.txt" and folder
"kernel-overlap-testing”

4) Select trace type "Automatic”, and select "Preserve Folder
Structure”

5) press Finish

Select an LTTng trace and open its context menu

Select the Open menu

Select the Copy menu and provide a new name. Open.
Select the Rename menu and provide a new name. Reopen.
Select the Delete menu and confirm deletion

Select trace and press Enter

Select trace and press Delete and confirm deletion
Double-click a trace

Open two traces. Open the first trace again.

Select the Experiments folder and open it context menu
Select the New menu and provide experiment name

Select an experiment and open its context menu

Select the Select Traces menu

Select a few LTTng traces and finish

Select the Open menu

Select the Copy menu and provide a new name. Open.
Select the Rename menu and provide a new name. Open.
Select the Delete menu and confirm deletion

Select an Experiment and press Enter (not numpad)

A dialog should ask the user to confirm
clearing of the folders. Clicking Yes should
remove everything under the selected folders
and close the traces

All the files get imported under their respective
folders. The CTF traces can be opened
(kernel-overlap-testing, simple_server...)

All traces are imported with trace type set. The
traces from folder "clashes" are renamed with
suffix (2). Make sure that the traces can be
opened

The specified traces are imported with trace
type set. Make sure that the traces can be
opened.

All the files get imported under their respective
folders. The CTF traces can be opened
(kernel-overlap-testing, simple_server...)

All traces are imported with trace type set. The
traces from folder "clashes" are renamed with
suffix (2). Make sure that the traces can be
opened

The specified traces are imported with trace
type set. Make sure that the traces can be
opened.

Correct menu opens (Open , Copy, Rename,
Trace is opened and views are populated
Trace is replicated under the new name
Trace is renamed. The trace editor is closed.
Trace is deleted. The trace editor is closed.
Trace is opened

Trace is deleted. The trace editor is closed.
Trace is opened

The first trace editor is simply brought to front.

Correct menu opens (New, Manage XML
Analysis, Refresh)
Experiment appears under folder, no traces yet

Correct menu opens (Select, Open , Copy,
Select Traces dialog is open and populated w/
Selected traces are imported in the experiment
Experiment opened and views populated
Experiment is replicated under the new name
Experiment is renamed

Experiment is deleted

Experiment is opened
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6.9

6.10

6.11

71
72

73

7.4

7.5

7.6

7.7

7.8

7.9

7.10

7.1

8.1

8.2

8.3
8.4

8.5

9.1

9.2

9.3

9.4

10.1
10.2
10.3

1"

Delete Experiment (Accelerator)
Delete Experiment (open
experiment)

Select Traces while Experiment is
open

Experiment Traces

Trace menu

Open trace

Remove trace

Drag and Drop from Traces

Drag and Drop from other Tracing
project

Drag and Drop from non-Tracing

Drag and Drop from external

Drag and Drop from external (non-
traces)

Drag and Drop of trace with
existing name

Drag and Drop of trace with
existing name (2nd time)

Drag and Drop of trace while
Experiment is open

Propagation
Preparation

Rename propagation

Delete propagation

Propagate trace type 1

Propagate trace type 2

Properties View
Synchronization

Trace synchronization

Other trace nodes synchronization
Check trace properties

Check trace properties -
experiment

Trace Type Selection

Preparation
Trace properties
Trace filtering

Supplementary Files

Select an Experiment and press Delete and confirm deletion
Open an experiment, select experiment and press Delete and
confirm deletion

Open an experiment and select an additional trace (see 6.3)

Select an LTTng trace and open its context menu

Select the Open menu
Open Experiment, select the Remove menu and confirm
removal

D&D a few LTTng traces from the Traces directory

D&D a few LTTng traces from another Tracing project's
Traces folder

D&D a few traces from a non-Tracing project, if dragging a
CTF it needs to be the whole folder and not just the file

D&D a few traces from an external file manager

D&D a few files (non-traces) from an external file manager

1) D&D a trace with name of an existing trace into experiment
folder

2) Confirm the renaming of traces

Redo test 7.8 with the same trace and same destination
folder

Open an experiment and D&D a trace from the Traces
directory (see 7.4)

Copy experiment

In Traces folder, rename a trace showing in both experiments

In Traces folder, delete a trace showing in both experiments

Add a trace to 2 experiments. Change its type from Traces
Add a trace to 2 experiments. Change its type from one of the
experiments

Select a trace under a Traces folder in Project Explorer view.
Repeat with trace under an Experiment.

Select a Traces folder, Experiments folder, or an experiment
in Project Explorer view.

Open an LTTng kernel trace, click on the trace, check the
new properties view.

Open an experiment which contains LTTng kernel traces,
click on the experiment, then select each trace under
experiment, check the new properties view.

Import a file with unrecognized trace type (${local}

] limport/unrecognized.log)

Select the trace and open the Properties View

Select an experiment and open "Select Traces..." dialog

Experiment is deleted

Experiment is closed and deleted
Experiment is closed and selected traces are
imported to the experiment

Correct menu opens w/ Copy disabled +
Remove

Trace is opened and views are populated
Experiment is closed, trace is removed from
experiment

Selected traces are added to the experiment
with proper icon. Experiment can be opened.
Selected traces are added to the experiment +
Traces with proper icon. Experiment can be
opened.

Selected traces are added to the experiment +
Traces with proper icon. Experiment can be
opened.

Selected traces are added to the experiment +
Traces with proper icon. Experiment can be
opened.

Selected traces are added to the experiment.
Traces with proper icon (system's). Experiment
cannot be opened.

Verify that trace is added into the traces folder
and experiment folder with the trace name of
the original trace plus a suffix (2)

Verify that trace is added into the traces folder
and experiemnt folder with the trace name of
the original trace plus a suffix (3)

Experiment is closed and selected traces are
imported to the experiment

Selected experiment is replicated

New name is propagated to both experiments
(and when renaming the experiment)
Selected trace is removed from both
experiments; also propagates when deleting
trace in experiment

Deleting all traces deletes the experiment

All occurences of that trace are updated

All occurences of that trace are updated

The Properties view is updated with the
selected trace's "Resource properties" Property
and Value. The "Info > type" property shows
the selected trace category and trace type
name.

The Properties view is updated with the
selected item's Property and Value. For
Experiment verify the "type" property is set.

"Trace properties" should be populated

The "Trace properties" should be populated for
every subtrace when it is selected

Imported trace appears in Traces with default
icon. File can be opened by default Editor
(either Eclipse text or system editor depending
on plug-ins installed)

Properties "type" and "type ID" are blank
Untyped trace does not appear in list
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11.1

1.2

1.3

1.4

1.5

11.6

1.7

1.8

1.9

11.10

1.1

11.12

11.13

121

122

12.3

124

125

12.6

131

13.2

13.3

13.4

Preparation

Create Supplementary File (State
History File) from trace

Trace Context sensitive menu
Delete Supplementary Files Action

Select and delete State History
File

Create Supplementary File (State
History File) from experiment

Delete Supplementary Files Action

Select and delete State History
File

Select and delete multiple State
History files

Delete Trace

Delete Experiment

Delete Experiment Trace

Delete Supplementary Files Action
while trace is open

Link With Editor

Preparation

Select trace/experiment in Editors
area

Select opened traces/experiments
in Project Explorer

Preparation
Select trace/experiment in Editors
area

Select opened traces/experiments
in Project Explorer

Trace Package Export Wizard

Preparation

Open the trace package export
wizard

Select Traces

Deselect/Select All

1) In Project Explorer remove filter for hidden resources
(Coolbar menu > Customize View... > unselect ".*
resources)

2) Create Experiment with 2 LTTng CTF traces in it

Open a LTTng CTF trace and wait for indexing to finish

a) Select trace under Folder Traces and click right mouse
button

b) Redo test: Select trace under Experiment Folder

c) Redo test: Select Experiment

1) Select trace and click right mouse button

2) Select 'Delete Supplementary Files...'

Select <trace name>/StateHistory.ht file and click on 'Ok’

Open Experiment with 2 LTTng CTF traces

1) Select Experiment and click right mouse button
2) Select 'Delete Supplementary Files..."

Select one history file (<trace name>/StateHistory.ht) and
click on 'Ok’

1) Redo 11.2 and 11.6

2) Select both history files and click on 'Ok’

a) Redo 11.2 to create Supplementary File
b) Delete trace

a) redo 11.6 to create experiment and Supplementary File
b) delete Experiment

a) redo 11.6 to create experiment and Supplementary File
b) remove traces under Experiment

Open trace and then redo 11.4
1) In Project Explorer make sure that “Link with Editor"

button is selected
2) Open multiple traces and experiments

Select several traces and experiments one after each other in

Editors area

Select several open traces and experiments one after each
other in Project Explorer

1) In Project Explorer make sure that "Link with Editor" button

is not selected
2) Open multiple traces and experiments (if not open)

Select several traces and experiments one after each other in

Editors area
Select several open traces and experiments one after each
other in Project Explorer

1) Import 2 traces that generate supplementay files
(trace2, kernel_vm)

2) Open both traces, wait for the indexing to finish

2) Add bookmarks in the two traces

Right Click on a trace ans select... “Trace Package Export”
and click Next

On the left side, select the project in which the traces were
imported. Then on the right side, select both traces.

With traces selected, press the Deselect All button. Then
press the Select All button. Click Next.

Verify that .tracing directory is shown under the
project

Verify that org.eclipse.tracecompass.analysis.
os.linux.kernel.ht is created under .

Verify that menu item 'Delete Supplementary
Files..." is shown in the context-sensitve menu
Verify that confirmation dialog box is opend
and <trace name>/StateHistory.ht is listed
Make sure that file .tracing/<trace
name>/StateHistory.ht is deleted from the
Verify that two StateHistory.ht files are created
under .tracing/<trace1 name>/ and .
Itracing/<trace2 name>/ respectively. Also
verify, that supplementatry folder for the

Verify that confirmation dialog box is opend
and shows 3 root entries:

<exp name>, <trace1 name> and <trace2
name>, with their respective supplementary

Make sure that the selected file .tracing/<trace
name>/StateHistory.ht is deleted from the
project explorer view

Make sure that both history files are deleted
under .tracing/<trace1 name>/ and .
tracing/<trace2 name>/ respectively

Verify that supplementary directory .
tracing/<trace name>/ is deleted.

Verify that supplementary File StateHistory.ht .
tracing/<trace1 name>/ and ./tracing/<trace2
name>/ are NOT deleted. Also verify that the
supplementary folder for the experiment .
Jtracing/exp_name_exp is deleted.

Verify that supplementary File StateHistory.ht .
tracing/<trace1 name>/ and ./tracing/<trace2
name>/ are NOT deleted

Verify that trace is closed and supplementary
files are deleted

Verify that after each selection the
corresponding trace or experiment element is
selected in the Project Explorer

Verify that after each selection the
corresponding trace or experiment is brought
to the top in the Editors area

Verify that selection in Project Explorer doesn't
change

Verify that Editor in focus is not changed

A wizard should appear with a list of projects
and traces to select. Next button should be

Next should become enabled when the first
trace is selected. If all traces are unselected,
the Next button is disabled.

Next should become disabled after Deselect
All, enabled after Select All.
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135

13.6

13.7

13.9

13.10

13.11

13.12

13.13

13.14

13.15

13.16

14.1

14.2

14.3

14.4

14.5
14.6

14.7

14.8

14.9

14.10
14.11

14.12

Trace element selection

Trace sub-element selection

Select/Deselect All

Archive file selection

Change export options, change
compression

Change export options, change
format

Change export options, change
format and compression

Finish the wizard

Overwrite

Verify formats

Verify content

Partial selection

Trace Package Import Wizard

Preparation
Open the trace package import
wizard

Project Selection

Archive file selection

Deselect/Select All
Trace element selection

Trace sub-element selection

Select/Deselect All

Finish the wizard

Supplementary Files

Bookmarks

Open from bookmark

Unselect the trace2 element

Unselect the kernel_vm > Trace element

With nothing selected, click Select All. Then click Deselect
All. Then click Select All again.

1) Click on the Browse button.
2) Select a location on the filesystem
3) Enter the file name export.tar

Unselect the “Compress” checkbox.
Change to Zip format

Change to Tar format then select the Compress checkbox.

Click Finish

Open the wizard again and select the traces (step 13.2,
13.3). Click Finish.

Open the wizard again and select the traces (step 13.2,
13.3). This time, choose Zip format. Click Finish.

Open the tar.gz and zip files in an archive manager.

Open the wizard again and select the traces (step 13.2,

13.3). This time, unselect both Supplementary files subtrees.

Click Finish.

Create an empty tracing project. Make sure you have
export.tar.gz available from the Trace Package Export
Wizard (13) test case, which should include everything
including trace files, | y files and export-
manifest.xml.

Click on “File”, “Import...”, “Tracing”, “Trace Package Import’
and click Next

Click the Select button. Choose the previously created
project.

1) Click on the Browse button.
2) Browse for export.tar.gz on the file system

With traces selected, press the Deselect All button. Then
press on the Select All button.
Unselect the trace2 element

Unselect the kernel_vm > Trace element

With nothing selected, click Select All. Then click Deselect
All. Then click Select All again.

Click Finish

Right-click on trace2 in Project Explorer

Open the Bookmarks view

Double click on one of the bookmarks

All elements in the trace tree are unselected,
the Approximate uncompressed size field
changes to a lower number.

All elements in the trace tree are unselected,
the Approximate uncompressed size field
changes to 0. The Finish button is disabled.
When Select All is clicked, all the tree elements
are selected, the approximate size increases.
When Deselect All is clicked, all the tree
elements are deselected and the approximate
size decreases.

Afile chooser dialog comes up. When the
destination file is entered, the “To archive file”
is filed with export.tar.gz. The Finish button
should be enabled.

The name of the archive file changes to export.
tar

The name of the archive file changes to export.
zip

The name of the archive file changes to export.
tar.gz

A progress bar should appear at the bottom the
the dialog and it should disappear upon
completion. The export.tar.gz file should be

The Archive file name should be remembered
and already filled. A dialog should prompt the
user to overwrite. Answering No should keep
the wizard opened. Answering Yes should re-
export the archive and close the wizard.

The export.zip file should be created on the file
system

In both archives, verify that it contains:

1) A trace folder for each trace containing all
the trace files (excluding supplementary files)
2) A .tracing folder containing all the
supplementary files

3) An export-manifest.xml file listing the trace
files, supplementary files and bookmarks
Verify that both exported archives contain:

1) A Traces folder containing all the trace files
(excluding supplementary files)

2) No .tracing folder

3) An export-manifest.xml file listing the trace
files and bookmarks

The first page of the wizard should appear
(Choose content to import)

The Into project field gets filled with the
selected project name.

Finish should be become enabled when the
first trace is selected. If all traces are
unselected, the Next button is disabled.
Finish should become disabled after Deselect
All, enabled after Select All.

All elements in the trace tree are unselected.

All elements in the trace tree are unselected.

When Select All is clicked, all the tree elements
are selected. When Deselect All is clicked, all
the tree elements are deselected..

A progress bar should appear at the bottom the
the dialog and it should disappear upon
completion. The two traces should appear
under the project in Project Explorer

Delete Supplementary files appears in the
content menu

Bookmarks view appears

The corresponding trace opens at the
bookmarked event. Bookmarks are displayed
in the event table.
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14.13

151

15.2

15.3

15.4

15.5

15.6

15.7

15.8

15.9

15.10

15.11

Overwrite

Time Offsetting

Preparation

Apply time offset dialog - trace
selection

Apply time offset dialog - folder
selection

Apply time offset dialog -
experiment selection

Apply time offset dialog - Basic
mode

Apply time offset dialog -
cumulative offset

Clear time offset

Apply time offset dialog -
Advanced mode

Apply time offset dialog -
Advanced mode - compute from
selection

Apply time offset dialog -
Advanced mode - compute from
entered values

Clear time offset with opened
traces

Open the wizard again (step 14.2) and select the archive file
(step 14.4). Click Finish.

Open Project Explorer view and Properties view. Create
an empty tracing project. Import two different traces to
the project. Open the traces and note their start time.
Close the traces.

Select both trace elements in the Project Explorer view.
Right-click and select Apply Time Offset...

Select the Traces folder element in the Project Explorer view.
Right-click and select Apply Time Offset...

Create an experiment with both traces. Select the experiment
element in the Project Explorer view. Right-click and select
Apply Time Offset...

Select a trace element in the Project Explorer view. Right-
click and select Apply Time Offset... In the Offset in seconds
column, enter a time with seconds and decimals. Click OK.
Open the trace.

Select the same trace element in the Project Explorer view.
Right-click and select Apply Time Offset... In the Offset in
seconds column, enter a time with seconds and decimals.
Click OK. Open the trace.

Select the trace element in the Project Explorer view. Right-
click and select Clear time offset. Click OK to confirm. Open
the trace.

Open one trace and close the other trace. Select both trace
elements in the Project Explorer view. Right-click and select
Apply Time Offset... Choose the Advanced radio button.

Double-click the second trace to open it. Select an event in its
trace editor. Select the first trace editor. Select an event in its
trace editor. Click the button in the dialog row of the second
trace. Click OK. Open both traces.

Select the first trace element in the Project Explorer view.
Right-click and select Apply Time Offset... Choose the
Advanced radio button. Double-click the trace name to open
it. Select the Reference time cell and copy the start time.
Select the Target time and paste the value. Edit both values
to different times. Click the button in the trace row. Click OK.
Open the trace.

Open both traces. Select both trace elements in the Project
Explorer view. Right-click and select Clear time offset. Click
OK to confirm. Open the traces.

A dialog should prompt the user to overwrite
for each trace. Answering Yes to All should
overwrite without prompting again.

The Apply time offset dialog opens in Basic
mode. The Trace name show both traces and
the Offset in seconds is blank.

The Apply time offset dialog opens in Basic
mode. The Trace name show both traces and
the Offset in seconds is blank.

The Apply time offset dialog opens in Basic
mode. The Trace name show both traces and
the Offset in seconds is blank.

The timestamps in the trace are all offset by
the entered value. The Properties view shows
the 'time offset' with the entered value.

The timestamps in the trace are all offset by
the cumulative sum of the previous and current
entered value. The Properties view shows the
‘time offset’ with the cumulative value.

The timestamps in the trace are back to their
original values. The Properties view shows the
‘time offset' as blank.

The Apply time offset dialog opens and is
switched to Advanced mode. The Trace name
shows both traces and the Offset in seconds is
blank. The Reference time for the opened trace
is set to its start time.

Both traces are open. Selecting an event
updates the Reference time for the selected
trace, and updates the Target time for all
traces. Pressing the button computes the
Offset in seconds as the difference between
Target time and Reference time for that row.
The trace which has a computed offset is
closed when the OK button is pressed. After
reopening, the two previously selected events
now have the same timestamp. The Properties
view (selected trace in Explorer) shows the
'time offset' with the computed value.

The trace is opened. The Reference time is set
to the trace start time. The Reference time and
Target time can be copied, pasted, and edited.
Pressing the button computes the Offset based
on the current time values. The trace is closed
with the OK button is pressed. After reopening,
the timestamps in the trace are offset
according to the computed value. The
Properties view shows the 'time offset' with the
computed value.

The opened traces are closed when the OK
button is pressed. After reopening, the
timestamps in the traces are back to their
original values. The Properties view shows the
'time offset' as blank.
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Manual

SWTBot

SWTBot
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Section
TMF - Bookmarks View
Unspecified

Test Case

Preparation
Preparation step 1

Trace bookmarks
Show Bookmarks View

Open trace

Add Trace Bookmark

Open Trace Bookmark (1)

Open Trace Bookmark (2)

Open Trace Bookmark (3)

Delete Bookmark (from
table)

Delete Bookmark (from
table)

Delete Bookmark (from
Bookmarks view)

Open and reset LTTng Kernel perspective

Select Bookmarks view (bottom folder)

Open an LTTng CTF Kernel trace

Add a bookmark, by

a) double-clicking on the left margin next to an event

b) right-clicking the margin and select Add bookmark....

c) using the Edit > Add bookmark... menu.

Enter the bookmark description in dialog box

Scroll within event table so that bookmark is not visible anymore
and then double-click on bookmark in Bookmarks View

Open another trace #2 and then double-click on bookmark in
Bookmarks view

Close the trace #1 and then double-click on bookmark in

Bookmarks view

Select bookmarks icon in event table right-click on icon and
select "Remove Bookmark"

Double-clicking bookmarks icon in event table.

Add a bookmark (see 2.4), then select bookmark in Bookmarks
view, right mouse click and select "Delete". Confirm the
deletion.

Verification

LTTng Kernel perspective opens with

Bookmaks view is shown

Views are populated. Verify that a
Kernel events editor is opened
showing LTTng Kernel specific
columns

Make sure that bookmark icon is
shown on left site of the event row
and is added to the Bookmarks view
with relevant information (i.e.
Description entered and correct trace
resource)

Make sure that event with bookmark
is selected and visible in event table
Make sure that correct trace #1 is
brought to top and correct event with
bookmark is selected in events table
Make sure that correct trace #1 is
opened and correct event with
bookmark is selected in events table
Make sure that bookmark icon is
removed from event table and
corresponding bookmark is removed
from the Bookmarks view

Make sure that bookmark icon is
removed from event table and
corresponding bookmark is removed
from the Bookmarks view

Make sure that bookmark icon is
removed from event table and
corresponding Bookmark is removed
from the Bookmarks view

Automated To Do Comments

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass




3.1

3.2

3.3

3.4

3.5

3.6

3.7

' Experiment bookmarks

Create and open
experiment

Add Experiment
Bookmark

Open Experiment
Bookmark (1)

Open Experiment
Bookmark (2)

Open Experiment
Bookmark (3)

Delete Bookmark (from
table)

Delete Bookmark (from
Bookmarks view)

Create Experiment with 2 LTTng CTF Kernel traces in it and
open experiment

Add a bookmark, by

a) double-clicking on the left margin next to an event

b) right-clicking the margin and select Add bookmark....

c) using the Edit > Add bookmark... menu.

Enter the bookmark description in dialog box

Scroll within event table so that bookmark is not visible anymore
and then double-click on bookmark in Bookmarks View

Open another trace #2 and then double-click on bookmark in
Bookmarks view

Close the experiment #1 and then double-click on bookmark in
Bookmarks view

Select bookmarks icon in Events view, right-click on icon and
select "Remove Bookmark"

Add a bookmark (see 6.4), then select bookmark in Bookmarks
view, right mouse click and select "Delete". Confirm the
deletion.

Verify that an Events editor is
opened showing LTTng Kernel
specific columns

Make sure that bookmark icon is
shown on left site of the event row
and is added to the Bookmarks view
with relevant information (i.e.
Description entered and correct
experiment resource)

Make sure that event with bookmark
is selected and visible in event table
Make sure that correct experiment #1
is brought to top and correct event
with bookmark is selected in events
table

Make sure that correct experiment #1
is opened and correct event with
bookmark is selected in events table
Make sure that bookmark icon is
removed from event table and
corresponding bookmark is removed
from the Bookmarks view

Make sure that bookmark icon is
removed from event table and
corresponding Bookmark is removed
from the Bookmarks view

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot




Section Fail Automated To Do Comments
TMF - Filters View 12 12 0 1

Target: Unspecified

Step Test Case Action Verification Type Comment

Open a trace to be

1 filtered Trace is opened SWTBot SWTBot Pass

2 Open filter view Filter view is opened SWTBot SWTBot Pass
Create a filter on event The filterview contains a filter on the event type and the

3 type and timestamp timestamp SWTBot SWTBot Pass

3.1 Apply that filter A subset of the events pass SWTBot SWTBot Pass

Create a filter on the
timestamp oring field

4 values Create the filter SWTBot SWTBot Pass

4.1 Apply that filter A subset of the events pass SWTBot SWTBot Pass
Create a filter with

5 equals node Create the filter SWTBot SWTBot Pass

5.1  Apply that filter A subset of the events pass SWTBot SWTBot Pass
Create a filter with

6 matches node Create the filter SWTBot SWTBot Pass

6.1 Apply that filter A subset of the events pass SWTBot SWTBot Pass
Create a filter with

7 contains node Create the filter SWTBot SWTBot Pass

7.1 Apply that filter A subset of the events pass SWTBot SWTBot Pass




Section Pass Fail Automated To Do Comments
TMF - Histogram View 1
Target: Windows

Step _Test Case Action Verification Type Comment
1 Preparation
LTTng Kerel perspective opens with
11 Stept Open and reset LTTng Kemel perspective correct views SWTBot
12 Step2 Open an LTTng trace Views are populated SWTBot

2 Manage View
Histogram View is removed from

21 Close view Close the Histogram View perspective SWTBot
Histogram View s dplayed and re-

22 Openview Window > Show View > Tracing > Histogram popul SWTBot
H\stugrzms are

23 Resize Resize the Histogram View width-wise compressedidecompressed without loss  SWTBot

3 Full Trace Histogram
Selection Start/End + blue bars are

31 Single selection Select timestamp with left-click Zoom window also moves Manual
Selection Start/End + blue bars are
updated

32 Range selection Select time range with ick, left-drag also moves. Manual
Zoom window is dragged, won't go

33 Drag zoom window Drag the zoom window leftight with ctri-left-drag or middie-drag heyond full range Manual

oom window is oenlered on click, won't
34 Move zoom window Move the z0om window with ctr-lef-click or middle-click go beyond full Manual

Zoomwindow s set Window Span s
updated, won't go beyond histogram

35 Setzoom window Set a new zoom window with right-drag range Manual
Zoom window is updated, Window Span
is updated, won't go below 2 ns, won't

36 Zoom infout Zoom inout with mouse wheel up/down exceed ful trace range Manual
Selection (blue bar) moves to the
previous/next non-empty bucket. A

37 Arrow keys Move the current event using leftight arrow keys bucket is one pixel width on the view Manual
Selection Start/End moves to
beginning/end of trace (i.. start time of

38 HomelEnd keys Press Home/End ke last bucket is selected) Manual
With a trace containing lost events, click the "Hide lost events™
toolbar icon. Click it again. The lost events (red bars) are toggled
39  Lostevents Use "Hello lost" in traces on and off. Manual
Zoom window is updated, Window Span
Zoom infout with +- key is updated, won't go below 2 ns, won't
310 Zoominfout (key) Reminder: + is shift = exceed ful trace range Manual
4 Time Range Histogram
Selection Start/End + blue bars are
41 single selection Select timestamp with left-click updated Manual
Selection Start/End + blue bars are
42 Range selection Select time range with shift-lefi-cick, shif-left-drag or left-drag  updated Manual
window s dragged, won'tgo
43 Drag zoom window Drag the zoom window leftight with ctrl-left-drag or middle-drag beyond full range Manual

Zoom window is updated, Window Span
is updated, won't go below 2 ns, won't

44 Zoom infout Zoom inout with mouse wheel up/down exceed ful trace range Manual
Selection (blue bar) moves to the
previous/next non-empty bucket, won't

45 Arrow keys Move the current event using leftright arrow keys excoed the zoom window Manual
Selection Start/End moves to
beginning/end of time range (i.. start

46 Home/End keys Press Home/End key time of last bucket is selected) Manual
Wit a race containing ot ovn's, cick the "Hide ot everts*  The ot events red bars) ar togged

47 Lostevents toolbar icon. Click it ag: on and off. Manual

Zoom window is updated, Window Span

Zoom inout with +- key is updated, won't go below 2 ns, won't

310 Zoom infout (key) Reminder, + s shift = exceed full trace range Manual

5 Selection Start/End

51 Set selection start Enter a TS within the fullrange in Selection Start widget Selection Start + blue bars are updated  Manual

52 Setselection end Enter a TS within the fullrange in Selection End widget Selection End + blue bars are updated  Manual
Select the link icon. Enter a TS within the full range in Selection ~ Selection Start/End + blue bars are

53 Set selection (inked) Start widget updated Manual

Selection Start + blue bar set to first

54 Setinvalid selection start Enter a TS before the full range start in Selection Start widget  event Manual
Selection End + blue bar set to last
55  Setinvalid selection end Enter a TS after the full range end i Selection End widget event Manual
6 Window Span
Both Histograms are updated
61 Setwindow span Enter a span in Window Span widget accordin Manual
62 Setlarge window span Enter an invalid span (too large) in Window Span widget Span set Ic full range Manual
Enter an invalid span (too small, negative, not a number) in
63 Setinvalid window span Window Span widget Span set to previous value Manual
Selected Timestamp
7
Time Range mouse Click on the time range histogram. The time of the bucket at the  Other views are synchronized to the
7.1 synchronization mouse position is selected. selected time Manual
Click on the fulltrace histogram. The time of the bucket at the  Other views are synchronized to the
72 Full Trace mouse synchronization  mouse position is selected. selected time Manual
Select the link icon in the ... menu. Enter a time within the full ~ Other views are synchronized to the
7.3 Selection synchronization (linked)  range in Selection Start widget selected time Manual
Selection Start/End + biue bars in both
In any other view that supports time synchronization, selecta  histograms are updated to the selected
7.4 External synchronization time. time Manual
Selected Time Range
8  Synchronization
Verify that the selected time range
Time Range mouse Solecta imo rango nthe smal Hstogram (shifet lic,lef-  shows in both histograms, and in other
81 synchronization drag or shiftleft drag). Manual
Vet hat th selectd time range
Select a time range in the full histogram (shiftleft click,left-drag, shows in both histograms, and in other
82 Full Trace mouse synchronization  shift-left drag). views. Manual
Selection Start/En Other views are synchorized t the
83 synchronization Enter a time within the full range in Selection StartEnd widget  selected time rang Manual
Iy other vew that support mo range aynchvonizaion,  Selecion SiarEnd + blue bars nboth
select a time range. histograms are updated to the selected
84 Extenal synchronization It can be larger than the time range time range. Manual
9 Zoom Window synchronization
Range mouse Select a zoom window in the small histogram (ctr-eft drag,  Other views are synchronized to the
91 synchronization middle-drag, right-drag, mouse wheel up/down). new range Manual
Select a zoom window in the full histogram (ctr-left drag, Other views are synchronized to the
92 Full Trace mouse synchronization  middle-click, middle-drag, right-drag, mouse wheel upidown).  new range Manual
Other views are synchronized to the
93 Window Span synchronization  Enter a new span in Window Span widget new range Manual
In any other view that supports range synchronization, selecta  Window Span and both histograms are
94 External synchronization new zoom window. updated to the new range Manual



10,

@

106
107

Multiple Trace Synchronization

Preparation
Open muliple traces (no overiap)

Change selected time and range
(no overlap)

Open multiple traces (overlap)

Change selected time and range
(overlap)

Select other trace (overlap)

Trace coloring
Close all traces

1) Download traces.zip (if necessary) and unzip into a local

directory ${local)

2) Import kernel trace ${local}traces/importikernel-overlap-

testing

3) Import UST ${local}itracesfimportitrace ust-overlap-
sting

4) Create experiment with traces of 2) and 3
‘Open multple traces that don't overlap in time

Select a time and new range

- Open multiple traces that overlap in time
- For both traces, in Events table right mouse-ciick -> Follow

time updates from other traces

Select a time and new range

Select different trace by clicking its editor tab

With an experiment containing multiple traces opened, click the
“Activate trace coloring" toolbar icon. Click it again.

Close all trace editor tabs

View shows the last opened trace
Selection Starl/End, Window Span and
both histograms are updated to selected
time and new range.

View shows the last opened trace
Selection Start/End, Window Span and
both histograms are updated to selected
time and new range.

View is updated to show selected trace.
Selection Start/End, Window Span and
both histograms are set to the newly
selected time and range.

The colors in both Histograms are
toggled on and off. When itis toggled
off, the legend disappears at the botiom
and only one color is used for non-lost
eve

View is cleared.

Manual
Manual

Manual

Manual

Manual

Manual

Manual
SWTBot

Not sure i the tests of secton 10 were done correcly:

steps done:

each trace.

traces



Section
TMF - Colors View

Target: Unspecified

Step Test Case

N —

AW

o O

Open a test trace
Open the colors view

Select a color and a filter
Add multiple colors
Change the color
priorities

Delete all the colors

Action

Atrace is visible in the events editor

The view is visible

Select a color and a filter, the matching events should update
their colors (background and foreground) to the new ones
Click on add 4 times, four colors should be displayed

By clicking on up and down, the order of the displayed colors
should change

The color filters should disappear.

Fail

Verification

SWTBot
SWTBot

SWTBot
SWTBot

SWTBot
SWTBot

Automated To Do Comments

6 0
Type
SWTBot Pass
SWTBot Pass
SWTBot Pass
SWTBot Pass
SWTBot Pass
SWTBot Pass

Comment



Section Pass Fail Automated To Do Comments
TMF - Sequence Diagram 37 ““ 2
Target: Ubuntu 20.04.5 LTS 64-bit

Step Test Case Action Verification Type Comment

1 Preparation
1) Download traces.zip (if necessary) and unzip
into a local directory ${local}
2 )Use traces simple-server-thread1 and simple-
server-thread2 under traces/import/ for test cases Note: Ul tests are not SWTBot, but JUnit tests. Tests are triggered
below programmatically right below the dialogs level
LTTng Kernel perspective opens with correct views:
Project Explorer, Control, Control Flow, Resources,

1.1 Open perspective Open and reset LTTng Kernel perspective Statistics, Histogram, Properties, Bookmarks SWTBot Pass
Open TMF Sequence Use menu Window — Show View — Other ... —
1.2  Diagram View Tracing — Sequence Diagram Verify that 'Sequence Diagram' view is shown SWTBot Pass
1) Create Tracing Project
2) Create Experiment (SeqExp) Verify that sequence diagram was loaded. The
3) Import 2 traces simple-server-thread1 and simple-  interaction show the signal numbers (Note that trace
server-thread2 doesn't contain strings for the interactions. A special
Create and open experiment  4) Add these 2 traces to experiment parser would be necessary to map signal number to
1.3  with sequence diagram data  6) Open (double-click on) the experiment trace) Manual Pass

2 Manage View

2.1 Close view Close Sequence Diagram view Sequence Diagram View is removed from perspective Manual Pass
Open view when 1) Close 'Sequence Diagram' View Verify that sequence diagram was loaded. Verify that
experiment/traces is already  2) load sequence diagram experiment all 17 pages are loaded. The hamburger menu should
2.2 loaded 3) Open Sequence Diagram view help. Manual Pass
3 Tooltip
1) Goto to first page (no selection of any interaction or  Verify that tooltip appears with content with interaction
lifeline) 2) Hover over first interaction (arrow or name and time stamp (10000 14:58:00.740995147).
3.1 Hover over interaction number) Tooltip is following the OS theme. UlTest Pass
Verify that tooltip appears with content with interaction
1) Goto to first page names and time stamp delta between selected
Hover over interaction after  2) select first interaction interaction and interaction that was hovered over
3.2  selection 3) Hover over 3rd interaction (10001 — 10000 delta: 000.000 157 023) UlTest Pass

Verify that tooltip appears with delta and graph to show
Hover over time compression Hover over first element in time compression bar on where delta is in relation to current configured min max
3.3  bar the left of the view values. (delta: 000.000 3 480) UlTest Pass

4 View Synchronization
Verify that interaction is highlighted in 'Sequence
Diagram'’ view. Verify that in the events table the
corresponding event is selected. Verify that time

4.1 Selection of interaction Select an interaction in the 'Sequence Diagram' stamps matches UlTest Pass
Selection of event in events  Select an sequence diagram event in the events table  Verify that corresponding interaction is selected in the
4.2 table (type SEND or RECEIVE) 'Sequence Diagram' view UlTest Pass

Verify that the content of the 'Sequence diagram'
changes and the interactions are part of the new
4.3  Selection of new time range  Change time range in 'Histogram View'. window range UlTest Pass

a

View Actions
Verify that different time ranges are selected when
changing page by looking at Histogram View.
Use buttons and menu items 'Go to next page', 'Go to  Histogram View window will show the start of the page.
previous page', 'Go to last page' and 'Go to first page' Note that there are 10000 interactions per page. In this
to navigate through trace. Use also menu item traces there are in total 160032 interactions. Verify that
5.1  Test page navigation 'Pages..." to jump to specific page last page has 32 interactions between 2 lifelines. SWTBot Pass

Verify that a dialog box will show. Verify that for this
trace it shows "Total: 17 pages is shown” and the
1) Select menu item 'Pages..." current page is displayed in the text box. After step 3)
2) In text box type “9” verify that page where changed to page 9. For this
5.2  Test menu item 'Pages...' 3) Click on 'OK' trace page 9 is the page with 3 lifelines. SWTBot Pass




53

5.4

55

5.6

5.7

5.8

59

5.10

5.1

5.12

5.13

5.14

5.15

5.16

5.17

Find of interaction

Find of lifeline

Find criteria persistence

Find short-cut

Filter of interactions

Filter of lifelines

Deselect filter

Filter criteria persistence

Zoom-in

Selection after zooming

Zoom-out

Reset zoom

Configure min/max

Configure min/max (default)

Show node end

Goto to page 1 —

1) Use button and menu item “Find”

2) select Interactions and deselect lifeline
3) type regular expression 10.*00

4) press find

5) press find

6) press find

7) press find

8) press find

Goto to page 1 —

1) Use button and menu item “Find”

2) select lifeline and deselect interaction
3) type player2

4) press find

5) press find

1) Restart eclipse

2) open find dialog

1) Select 'Sequence Diagram' view

2) press CTRL+f

Goto to page 1 —

1) Use menu item 'Hide Patterns...'

2) Press Add

3.1) select Interactions and deselect Lifeline
3.2) type regular expression 10.*03

4) Press 'Create’

5) Press 'Ok’

Goto to page 9 —

1) Use menu item 'Hide Patterns...'

2) Press Add

3.1) select Lifelines and deselect Interactions
3.2) type regular player2

4) Press 'Create’

5) Press 'Ok’

1) Apply one filter

2) Use menu item 'Hide Patterns..."

3) deselect filter

4) click 'Ok’

1) Restart eclipse

2) open hide dialog

1) Use button and menu item for zoom-in to activate
zooming in

2) click into sequence diagram view

1) Click on button and menu item 'Select' to go back to
selection mode

2) select an interaction

1) Use button and menu item for zoom-out to activate
zooming out

2) click into sequence diagram view

1) Use button and menu item for 'Reset zoom factor' to
reset the zoom level

1) Select menu item 'Configure Min Max'

2) Change min to 100 and max to 2000 (keep scale
and precision)

3) press 'Ok’

After changing min and max

1) select menu 'Configure Min Max'

2) press 'Default’ 3) press 'Ok’

Goto to page 1 —

1) Resize view so that the arrow (pointer) of the
interaction is not shown

2) select on interaction

3) Use menu item Navigation — Show node end

After 4) verify that interaction 10000 (player1 —
master) is selected. After 5) verify that interaction
10100 (master — player1) is selected. After 6) verify
that 10000 (player2 — master) is selected. After 7)
verify that interaction 10100 (master — player2). After
8 nothing else will be found

After 4) verify that lifeline with name player2 is selected
(page 9 with 3 lifelines). After 5) player2 is selected on
page 10

Verify that previous used find criteria are still in the list.

Verify that find dialog opens

After 5) verify that Interactions with name 10003 and
10103 are not shown

After 5) verify that player2 is not shown

Verify that all lifelines and interactions are shown
Verify that previous used hide criteria are still in the list

Verify that 'Sequence Diagram' view zooms in. Note
that no selection is possible.

Verify that selection is possible.

Verify that 'Sequence Diagram' view zoom out. Note
that no selection is possible.

Verify that 'Sequence Diagram' view goes back to
default zoom

After 1) verify that a dialog box shows with default
values. After 3) verify that time compression bar
changes some colors. It will show more deeper red
because the max value is lower.

After step 2) the default values are shown. After step 3)
the time compression bar will change colors. Note that
the default values are computed based on all deltas of
2 consecutive interactions.

Verify that end lifeline of the interaction (the arrow) is
shown if it fits the screen

SWTBot

SWTBot

Manual

Manual

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

Manual

https://bugs.eclipse.org/bugs/show_bug.cgi?id=581104
Sehr: This bug is still relevant



5.18

5.19

5.20

5.21

5.22

5.23

5.24

5.25

5.27

Show node start

Show node end short-cut

Show node start short-cut
Scroll down short cut

Scroll up short cut

Overview feature

Print

Remove filter (Bug 391714)

Time Sync. without
interactions (Bug 391716)

Goto to page 1 —

1) Resize view so that the beginning of the interactions
are not shown

2) select on interaction

3) Use menu item Navigation — Show node start

Goto to page 1 —

1) Resize view so that the arrow of the interaction is
not shown

2) select on interaction

3) Press SHIFT+ALT+END

Goto to page 1 —

1) Resize view so that the arrow of the interaction is
not shown

2) select on interaction

3) Press SHIFT+ALT+HOME

Press SHIFT+ALT+ARROW_DOWN
Press SHIFT+ALT+ARROW_UP

Goto page 9 — Keep pressing + icon at the lowest
right corner of the view and drag down, up, left or right
Select 'Sequence Diagram' view and press printer icon
in the Eclipse's tool bar (or use CTRL+P). Select one
pager page to print

1) Create 1 filter ("Hide Patterns") if necessary (see
5.8)

2) Open Error Log view if necessary

3) Open filter dialog box and remove all filters

4) Press 'Ok’

5) Open filter dialog box again

1) Open trace without any sequence diagram
information

2) Open SD view if necessary

3) Open Error Log view if necessary

4) change time range in Histogram view

5) Change time current selected time in Histogram
View

Verify that start lifeline of the interaction is shown

Verify that end lifeline of the interaction (the arrow) is
shown

Verify that start lifeline of the interaction is shown
Verify that within a page the display scrolls down per
view size

Verify that within a page the display scrolls up per view
size

Verify that it's possible to navigate through a page of
the sequence diagram view

May be hard to see.

Verify that it is possible to print

Verify that no exceptions occurred and after 5) no
filters are listed

Make sure that no exceptions occurred

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

GTK 3 problem ?

Pass on 16.04 and 16.10... could it be cups giving you a hard time?



Section Automated To Do Comments
TMF - Statistics View

Target: Windows

Step Test Case Action Verification Type Comment

1 Preparation
Download traces simple-server-thread1 and simple-server-

Preparation thread1 from traces/import/
1.1 Open Perspective Open and reset LTTng Kernel perspective LTTng Kernel perspective SWTBot Pass
When running the Trace Compass RCP:
Use menu Window — Show View — Tracing — Statistics
When running Trace Compass installed in Eclipse:
Use menu Window — Show View — Other ... — Tracing — Verify that 'Statistics' view is
1.2  Open TMF Statistics View Statistics shown SWTBot Pass
1) Create Tracing Project Verify that statistics are shown
2) Create Experiment (SeqExp) per trace and per event type.
3) Import 2 traces simple-server-thread1 and simple-server- Each trace has 80021 events.
thread2 Verify that event types
4) Select trace type "Generic CTF Trace" ENTER/RETURN/SEND/RECE
5) Add these 2 traces to experiment IVE/INFO/after_fork_child are
1.3 Open experiment counted. RCPTT Pass
2 Manage View
21 Delete view Close the 'Statistics' View Statistics' view is removed from  RCPTT Pass
Statistics' view View is
2.2  Open view Use menu Window — Show View — Tracing — Statistics displayed and re-populated RCPTT Pass
Open view when Verify that statistics are shown
experiment/trace is 1) Close 'Statistics View' 2) load trace above trace 3) Open per trace and per event type.
2.3  already loaded 'Statistics' view Each trace has 80021 events.  RcpTT | Pass
3 Other
Verify that 'Statistics' view is
populated gradually during
3.1 Build of statistic index Open trace indexation Manual Pass
Verify that when opening the
Open same trace multiple times after indexing of trace was trace the x-times (x > 1), that
3.2 Persistence of statistics  finished the first time the statistics appear right away  Manual Pass

4 Range Synchronization

Events in 'Events in selection’

External synchronization  In any other view that supports range synchronization, select is updated and equals 'Events Automation
4.1 (full) the full range of the trace. total' values Manual Pass Candidate
Events in 'Events in selection’
External synchronization  In any other view that supports range synchronization, select a is updated according to new Automation

4.2 (range) new range. range Manual Pass Candidate




5.1

5.2

5.3

54

5.5

5.7
5.8

Multiple Trace
Synchronization

Preparation
Open multiple traces (no
overlap)

Change selected time and
range (no overlap)

Select other trace (no
overlap)

Open multiple traces
(overlap)

Change selected time and
range (overlap)

Select other trace
(overlap)

Close all traces

1) Download traces.zip (if necessary) and unzip into a local
directory ${local}

2) Import kernel trace ${local}/traces/import/kernel-overlap-
testing

3) Import UST ${local}/traces/import/trace ust-overlap-
testing

4) Create experiment with trace of 2) in it

Open multiple traces that don't overlap in time

In any other view that supports range synchronization, select a
new range

Select different trace by clicking its Events editor tab

- Open multiple traces that overlap in time

- For both traces, in Events table right mouse-click -> "Follow
time updates from other traces"

In any other view that supports range synchronization, select a
new range

Select different trace by clicking its Events editor tab
Close all Events editor tabs

View shows the last opened
trace

Events in 'Events in selection’
is updated according to new
View is updated to show
selected trace. 'Events in
selection' is updated according

View shows the last opened
trace

Events in selection' is updated
according to new range

View is updated to show
selected trace. 'Events in

View is cleared.

Manual

Manual

Manual

Manual

Manual

Manual
SWTBot

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate



Section
TMF - Time Chart View

Target: Windows

Step Test Case

1

1.1
1.2

2.8
2.9

w

Preparation

Preparation step 1

Preparation step 2

Trace handling

Open trace

Open other trace

Open experiment

Select other trace

Select other trace (external)
Close view

Open view

Close trace/experiment

Close last trace

Time Synchronization

Mouse synchronization (single time)

Mouse synchronization (time range)

External synchronization (single time)

External synchronization (time range)

Zoom Range Synchronization

Mouse wheel synchronization

Pass

Action

Open and reset LTTng Kernel perspective

Show Time Chart View

Open an LTTng CTF Kernel trace #1

Open an LTTng CTF Kernel trace #2

Open an experiment

Select trace #1 by clicking its trace entry in Time Chart view

Select trace #2 by clicking its editor tab
Close the Time Chart view

Show Time Chart view

Close trace #2 editor tab. Repeat with experiment editor tab.

Close trace #1 editor tab

Left-click on the time chart. The selected time line is updated.

Shift-left-click or left-drag on the time chart. The selected time
range is updated.

In event table, select an event.

In event table, select an event range with shift-left-click.

Zoom in/out with mouse wheel while holding Ctrl.

Fail

Verification

LTTng Kernel perspective opens
with correct views.

Time Chart view is shown

Trace #1 entry added to Time Chart
view. Trace #1 is the active trace.
Range of view is full trace range.
Trace #2 entry added to Time Chart
view. Trace #2 is the active trace.
Range of view is union of full trace
ranges. Dates may be hard to read
Experiment entry added to Time
Chart view. Experiment is selected
entry. Range of view is union of full
trace ranges.

Trace #1 is selected entry. View
range does not change. Trace #1
editor tab is brought to top.

Trace #2 is selected entry. View
range does not change.Color may
be subtle

Time Chart view is removed from
tracing view

Time Chart view is displayed and re-
populated with opened traces data
Trace entry is removed from Time
Chart view. Range viewed is union
of remaining full trace ranges.

View is cleared.

Other views are synchronized to the
selected time. Event at or following
the selected time is selected in the
event table.

Other views are synchronized to the
selected range. Event at or following
the selected time is selected in the
event table.

Selected time line is updated to the
event time. The window range will
update if the selection is out of
ranve.

Selected time line is updated to the
time range.

Other views are synchronized to the
new range

Automated To Do
1 0
Type
SWTBot Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass

Manual Pass

Comments
1

Comment

Candidate for incubator

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate
Automation
Candidate



4.2

4.3

44

4.5

Mouse drag zoom synchronization
Mouse drag move synchronization
Mouse full range synchronization

External synchronization

Event Table Synchronization

Search synchronization
Search cleared

Filter synchronization
Filter cleared

Bookmark synchronization
Bookmark cleared

Drag zoom with 1. right-button, 2. drag to select new zoom
range -on time chart.

Drag move with ctrl-left or middle button on time chart.
Double-click with left button on time chart's time scale.

In any other view that supports range synchronization, select a
new zoom range.

Enter a search regex in event table
Clear the search regex in event table

Enter a filter regex in event table from the filter view
Clear the filter regex in event table

Add a bookmark in event table
Remove the bookmark in event table

Other views are synchronized to the
new range

Other views are synchronized to the
new range

Other views are synchronized to the
full range

View range is updated to the new
range

Matching events are marked in time
chart

Marks are removed in time chart
Non-matching events are removed
from time chart

All events are shown in time chart
Bookmarked event is marked in time
chart

Mark is removed in time chart

Manual

Manual

Manual

Manual

Manual
Manual

Manual
Manual

Manual
Manual



Section Pass Fail Automated To Do Comments
TMF - Custom Parsers 28 12 0 0
Target: Windows

Step Test Case Action Verification Type Comment

0 Prerequisites
In the trace compass git, get the traces
located in org.eclipse.
tracecompass/tmf/org.eclipse.
tracecompass.tmf.core.tests/testfiles/xml
get the definitions (testDefinition.xml) and
0.1 Get custom parser definition and logs the valid traces in the valid subdirectory.  https://drive.google.com/drive/folders/1DJ2FSYWi1u8HHfi2HWCtoAOKcCpZMDr8?usp=sharing

traces.zip is located in this folder

1 View management
Open and reset Tracing perspective, and

1.1 Open perspective open Time Chart view Time Chart view opens. SWTBot Pass
Create a tracing project, open Manage  Custom parsers imported (TmfGeneric,
1.2 Import custom parser definitions Custom Parsers dialog and importtext  Custom XML Log) RCPTT Pass

Traces imported in Traces folder of project
(ExampleCustomTxt.log,
Create a tracing project and import a text ExampleCustomXml.xml) and have their trace
1.3 Import custom traces and XML custom trace type auto-selected. RCPTT Pass

2 Custom parser management

Open Manage Custom Parsers dialog in
2.1 Open Manage Custom Parsers dialog Traces folder context menu Dialog opens. SWTBot Pass

Select "Text" radio button, click New...
button, enter Trace type, change stuff,

2.2  New (text) click Next, click Finish Custom parser appears in list. SWTBot Pass
Select custom parser, click Edit..., change Previously entered data appears, can be

2.3 Edit (text) stuff, click Next, click Finish edited. SWTBot Pass
Select custom parser, click Export, enter

2.4  Export (text) name, click Save Exported custom parser stored in file system. RCPTT Pass

2.5 Delete (text) Select custom parser, click Delete Custom parser is deleted. SWTBot Pass
Click Import, find custom parser definition,

2.6 Import (text) click Open Imported custom parser appears in list. RCPTT Pass

Select "XML" radio button, click New...
button, enter Log Type, write an xml log in
the input,
<a><b><c>1</c><d>1</d></b><b><c>2</
c><d>1</d></b></a> then click on the
"feeling lucky" button. Set b to log entry,
set c to timestamp logged and d to
message logged, set timestamp format to

ss in both text boxes, click Next, click Automation
2.7 New (XML) Finish Custom parser appears in list. Manual Pass Candidate

Select custom parser, click Edit..., change Previously entered data appears, can be Automation
2.8  Edit (XML) stuff, click Next, click Finish edited. Manual Pass Candidate

Select custom parser, click Export, enter Automation

2.9  Export (XML) name, click Save Exported custom parser stored in file system. Manual Pass Candidate




2.10

2.1

3.1

3.2
3.3

34

3.5

3.6
3.7

3.8

4.1

4.2

4.3

4.4

4.5

4.6

Delete (XML)
Import (XML)

Custom parser trace handling

Select trace type (text)

Open trace (text)
Raw view (text)

Time synchronization (text)

Select trace type (XML)

Open trace (XML)
Raw view (XML)

Time synchronization (XML)

Raw viewer

Show Raw Viewer
Hide Table

Show Table

Select Event (Bug 457852)

Select Event using arrow keys
(457852)

Hide Raw viewer

Select custom parser, click Delete

Click Import, find custom parser definition,
click Open

Select test file in Traces folder, right-click,
select "Select Trace Type > Custom Text
> (parser name)"

Double-click on test file in Traces folder
Right-click in editor, click Show Raw
Click in Time Chart view, select event in
editor table, select event in raw view
Select test file in Traces folder, right-click,

select "Select Trace Type > Custom XML
> (parser name)"

Double-click on test file in Traces folder
Right-click in editor, click Show Raw

Click in Time Chart view, select event in
editor table, select event in raw view

1) Open Custom text trace
2) Right-click in table and select "Show
Raw"

Right-click in table and select "Hide
Table"

Right-click in raw viewer and select "Show
Table"

Select event in raw viewer

1) select event in raw viewer with mouse
2) use arrow key down and up several
times

Right-click in table and select "Hide Raw"

Custom parser is deleted.

Imported custom parser appears in list.

Trace type is assigned (re-open Select Trace
Type sub-menu to verify)

Editor opens with events table, Time Chart
view is populated.

Editor is split with raw view on right pane.

All three widgets synchronize to selected
time.

Trace type is assigned (re-open Select Trace
Type sub-menu to verify)

Editor opens with events table, Time Chart
view is populated.

Editor is split with raw view on right pane.

All three widgets synchronize to selected
time.

Raw viewer is shown beside the events table

Events table is hidden and only raw viewer is
shown

Events table is shown beside raw viewer
Correct event is select in table, timestamp is
propagated to other TMF views and
Properties view shows content of selected
event

Correct event is select in table, timestamp is
propagated to other TMF views and
Properties view shows content of selected
event

Raw viewer is hidden and only events table is
shown

SWTBot

Manual

RCPTT

Manual
Manual

Manual

RCPTT

Manual
Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Automation
Candidate



Section Pass Fail Automated ToDo Comments
TMF - State System Explorer 12 ““ 0
Target: Windows

Step Test Case Action Verification Comment Test that will make this swtbot

1 Preparation
Use menu Window — Show View —
1.1 Open TMF State System Explorer View Tracing — State System Explorer Verify that 'State System Explorer' view is shown SWTBot Pass 84711

2 Manage View
'State System Explorer' view is removed from

2.1 Delete view Close the State System Explorer' View perspective SWTBot Pass 84711
Use menu Window — Show View — 'State System Explorer' view is displayed and re-
2.2 Open view Tracing — State System Explorer populated SWTBot Pass 84711

Verify that view is populated with kernel state
system (o.e.t.analysis.os.linux.kernel) and
statistics state systems (o.e.l.tmf.statistics.*) of

2.3  Open Trace Open an LTTng Kernel Trace opened trace SWTBot Pass 84711
1) Close State System Explorer View
2) Load LTTng trace Verify that view is populated with state systems

2.4 Open view when trace is already loaded 3) Open 'State System Explorer' view from trace SWTBot Pass 84711

Verify that view is populated with all kernel state

Open Experiment with 2 or more LTTng system and statistics state systems of opened
2.5  Open Experiment traces experiment (separated by trace) RCPTT Pass
View is updated to show selected trace. State

values, start time and end time are updated

Select different trace by clicking its Events according to the selected trace's previously

2.7  Select other trace editor tab selected range. Manual Pass Automation Candidate
Verify that view is populated with state systems
2.6 Restart Restart Eclipse from trace Manual Pass
Close traces and experiment one by one  Verify that state system explorer view is cleared
2.7 Close all traces from the editor tab after closing the last trace Manual Pass Automation Candidate
3 Timestamp / Time Range Selection
Select time in another view (e.g Histogram
3.1 Select timestamp view) that supports time synchronization Verify that selection time is updated in view Manual Pass It's an abstract time graph view
Select a time range in another view that
3.2  Select time range supports time synchronization Verify that selection time range is updated in view  Manual Pass It's an abstract time graph view
4 Displaying of Changed Values

Select many different timestamps one after Selection time bar is over the current time and
Manual Pass

41 Highlighting of changed values the other state value of Attribute is shown Automation Candidate



Section
TMF - Flame Chart View

Target: Ubuntu 20.04.5 LTS 64-bit

Step Test Case

0
1

1.1

3.2
3.3
3.4
3.5

4

Download the test resources
Preparation

Open TMF Flame Chart View
Import generic trace
Import cyg-profile trace

Import cyg-profile-fast trace

Manage View
Close view

Open view

Open Trace

Open view when trace is already
loaded

Open Experiment
Select other trace
Restart

Close all traces

Navigation

Select time

Select Previous/Next Event
Zoom to function (table)
Zoom to function (time graph)
Go to first event in trace

Synchronization

Pass

Action
Download this

Use menu Window — Show View — Other ...
— Tracing — Flame Chart

Import a trace that does not have any call
stack information, like a standard kernel trace
Import the trace in the "trace" directory of the
downloaded zip

Import a trace in the "trace-fast" directory of
the downloaded zip

Close the Flame Chart View
Use menu Window — Show View — Other ...
— Tracing — Flame Chart

Open "trace(-fast)" trace

1) Close 'Flame Chart' view

2) Open "glxgears-cyg-profile(-fast)" trace
located in the git in ctf test

3) Open 'Flame Chart' view

Open Experiment with 2 or more Flame Chart
traces.

(You can use both traces)

Select different trace by clicking its Events
editor tab

Restart Eclipse with Flame Chart trace opened
Close traces and experiment one by one from
the editor tab

Click on random time in the time graph pane

Click Previous/Next Event button

Double-click on a function in the table pane
Double-click on a function (interval) in the time
Go to events editor, press home

Fail

Verification

Verify that 'Flame Chart' view is shown

Verify that nothing is shown in the view, except
“Stack info not available (<tracename>)"
Verify that the Flame Chart View is populated
with some callstack information.

Verify that the Flame Chart View is populated
with some callstack information.

Flame Chart' view is removed from perspective

Flame Chart' view is displayed and re-populated
Verify that view is populated with call stack
information

Verify that view is populated with call stack
information

Verify that view is populated with all call stack
information (separated by trace).

View is updated to show selected trace.

Verify that view is populated with call stack from
trace

Verify that Flame Chart view is cleared after
closing the last trace

Selected time line is updated. Table is updated to
show the full stack information at the selected
time. Selected time is updated in other views.
Previous or next call stack change is selected
and corresponding active function and stack
depth is selected. Table is updated to show the
full stack information at the selected time.

Time range is updated to the full duration of the
Time range is updated to the full duration of the
the Flame Chart view is updated

Automated To Do
14 0
Type
SWTBot Pass
Manual Pass
SWTBot Pass
SWTBot Pass
Manual Pass
SWTBot Pass
SWTBot Pass
SWTBot Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
SWTBot Pass
SWTBot Pass
SWTBot Pass
SWTBot Pass
Manual Pass

Comments
1

Comment

Automation Candidate

Automation Candidate

Automation Candidate

Automation Candidate

Automation Candidate

Automation Candidate

Automation Candidate


https://drive.google.com/file/d/0BxUCnNTRLr5pWUdXd0JJV3hyeEk/view?usp=sharing&resourcekey=0-mwiFdd-ZGrgvqv63CdLaHQ

4.1

4.2
4.3

5.1

5.2

6.1

6.2

Time synchronization

Event synchronization
Time range synchronization

Function name import - Text file

Invalid text file import

Valid text file import

Function name import - CDT

Binary import

Binary import Ittng 2.8+

Select a random time in another view
Select a call stack-impacting event (function
entry/exit) in events table

Select a new time range in Histogram view.

Open 'trace’ from Fibonacci.zip. Click the
"Configure ..." button in the view and click
"Browse" to select a random .txt file that does
not contain any debugging info.

Import a file "fibonacci.symbols"

Click the "Configure ..." button in the view and
click "Browse" to select the fibonacci
executable (fibonacci).

Open an Ittng 2.8+ trace with the executable
present

Selected time line is updated. Table is updated to
show the full stack information at the selected
time. If selected time is outside current range,

In addition to updating the selected time, the
active function at the event time is selected.
Time range is updated.

The function addresses do not change. Says "the
following file(s) are invalid"

The view now displays function names instead of
function addresses (both in the timegraph and
the call stack areas).

The view now displays the function names for
both traces

The view now displays the function names for the
trace

SWTBot

SWTBot
SWTBot

Manual

SWTBot

Manual

Manual

Automation Candidate



Target:

21

2.2

3.1

3.2

3.3

34
3.5

3.6

3.7
3.8

4.1

4.2

4.3

4.4

5.1
5.2

Section
TMF - Remote Fetching
Ubuntu 20.04.5 64-bit

Test Case

Preparation

Step 1

Opening

Open Profile Editor 1
Open Profile Editor 2

Edit Profile - Add/Delete

Create Profile
Add Node
Add trace group

Add trace
Delete Trace

Delete Trace Group

Delete Connection Node
Remove Profile

Edit Profile - Reorder

Move profile up/down

Move connection node up/down

Move Trace Group up/down

Move Trace up/down

Edit Profile - Copy, Cut, Paste

Copy/Paste Profile
Copy/Paste Profile (Keys)

Action

Open Trace Compass and reset Lttng
perspective

Right-click on Traces Folder -> Fetch Remote
Traces ... -> Manage Profiles

Window -> Preferences-> Tracing -> Remote
Profiles

Open Profile Editor > Click on 'Add' > Enter
profile name, remote information, root path and
trace pattern

Select Profile node > right mouse click > select
'New Connection Node'

Select node node > righ mouse click > select
'New Trace Group'

Select trace group > right mouse click > select
'New Trace'

Select trace > right mouse click > select Delete
Select Trace Group> right mouse click > select
Delete

Select Connection Node > right mouse click >
select Delete

Select Profile > click on 'Remove' button

Create at 2-3 profiles > select 2nd profile and
press buttons 'Move Up'/'Move Down'

Make sure that there are 2 or 3 connection
nodes > select 1 connection node > click buttons
'Move Up'/'Move Down'

Make sure that there are 2 or 3 trace gropus >
select 1 trace group > click buttons 'Move
Up'/'Move Down'

Make sure that there are 2 or 3 trace groups >
select 1 traces > click buttons 'Move Up'/'Move
Down'

Select Profile > click right mouse button on a
profile > Select Copy -> click right mouse button
on other profile > Select Paste

Redo 5.1 with CTRL+C and CTRL+V keys

Verification

Lttng perspective opens with correct views

The Profile Editor of preference page opens

The Profile Editor of preference page opens

New Profile is created and template is
provided

New Connection Node is create under the
profile and template is provided

New Trace Group is created under the node
and template is provided

New Trace is created under Trace Group and
template is provided

Trace is deleted

Trace Group is deleted

Connection Node is deleted
Profile is deleted

Profiles are moved up and down

Connection Nodes are moved up and down
within a profile

Trace Groups are moved up and down within
a connection node

Traces are moved up and down within a Trace
Group

Profile is pasted under the selected profile
Profile is pasted under the selected profile

Automated To Do Comments

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot
SWTBot

RCPTT

RCPTT
SWTBot

RCPTT

RCPTT

RCPTT

SWTBot

RCPTT
RCPTT

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass




5.3

5.4

5.5

5.6

5.7

5.8
5.9

6.1

6.2

6.3

6.4

6.5

6.6

6.7

6.8
6.9

71

7.2

7.3

8.1

Copy/Paste Connection Node
Copy/Paste Connection Node
(Keys)

Copy/Paste Trace Group
Copy/Paste Trace Group (Keys)
Copy/Paste Trace

Copy/Paste Trace (Key)
Cut/Paste

Edit Profile - Adverserial
Error empty profile name

Duplicate profile name

Error empty Connection node
name

Duplicate Connection node name
Missing username in URI

Invalid URI

Error empty Trace Group

Error empty Trace
Invalid File pattern

'Exportllmport Profile

Export Profile
Import Profile

Import Profile

'Remote Fetch Wizard

Preparation

Select Profile > click right mouse button on a
Connection Node > Select Copy -> click right
mouse button on other Connection Node >
Select Paste

Redo 5.3 with CTRL+C and CTRL+V keys
Select Profile > click right mouse button on a
Trace Group > Select Copy -> click right mouse
button on other Trace Group > Select Paste

Redo 5.5 with CTRL+C and CTRL+V keys
Select Profile > click right mouse button on a
Trace > Select Copy -> click right mouse button
on other Trace > Select Paste

Redo 5.5 with CTRL+C and CTRL+V keys
Redo 5.1 - 5.8 with cut and paste

Clear profile name
Add profile with name of existing profile

Clear Connection node name

Within a profile, add Connection node with name

of existing node

remove user name of a Connection Node
add invalid URI

Delete Trace Group root path

Delete File Pattern
Add trace with invalid regular expression

Select multipe profiles > Click Export Button >
Select Folder and enter file name > OK

Click on Import Button > select profile XML file >

OK

Redo 7.2

1) Generate CTF trace in
<plugin>/generated/synthetic-trace

2) Import profiles from <plugin>/profiles/test-
profiles.xml

Profile is pasted under the selected
Connection Node
Profile is pasted under the selected
Connection Node

Profile is pasted under the selected Trace
Group
Profile is pasted under the selected Trace
Group

Profile is pasted under the selected Trace
Profile is pasted under the selected Trace
Successful cut and paste

Error message "Profile must not be empty"
Error message "<name>: Duplicate profile
name"

Error message "Node name must not be
empty"

Error message "Duplicate node names"

Error message "URI must include user
information"

Error message "URI must include valid host
and port number" or "Unsupported URI
scheme"

Error message "Root path must not be empty"
Error message "File pattern must not be
empty"

Error message "Invalid file pattern"

Only selected profiles are exported

Profiles are imported
after second import an error message appears
"Duplicate profile names"

RCPTT

RCPTT

RCPTT

RCPTT

SWTBot

RCPTT
RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT
RCPTT

SWTBot

SWTBot

SWTBot

SWTBot




8.2

8.3

8.4

8.5

8.6

8.7

8.8

Create and run Profile "new
Profile" (syslog + synthetic CTF
trace in sub-directory)

Clear traces

Create and run Profile "new
Profile" (syslog + synthetic CTF
trace in sub-directory), only 1
trace selected

Clear traces

Run Profile "TestAllRecursive"

Re-run Profile "TestAllRecursive"
(Rename)

Re-run Profile "TestAllRecursive"
(Overwrite)

Re-run Profile "TestAlIRecursive"
(Skip)

Re-run Profile "TestAlIRecursive"
(Overwrite 2)
Clear traces

1) Create Profile with Local connection, 1 trace
group (root /tmpl/traces/) and 2 traces (.*syslog.*
and .*synthetic.*) in this group

2) Select profile in Fetch Remote Traces wizard
(Remote Profile page)

3) Click on 'Next' button

4) Click on 'Finish'

Delete all traces from Traces directory

1) Create Profile with Local connection, 1 trace
group (root /tmp/traces/) and 2 traces (.*syslog.*
and .*synthetic.*) in this group

2) Select profile in Fetch Remote Traces wizard
(Remote Profile page)

3) Click on 'Next' button

4) deslect the synthetic CTF trace

5) Click on 'Finish'

Delete all traces from Traces directory

1) Select profile "TestAllRecursive" in Fetch
Remote Traces wizard (Remote Profile page)
2) Click on 'Next' button (enter password if
needed)

3) Click on 'Finish’

1) Select profile "TestAllRecursive" in Fetch
Remote Traces wizard (Remote Profile page)

2) Click on 'Next' button (enter password if
needed)

3) Click on 'Finish’

4) In dialog box select 'Rename'’ for the first trace
and 'Rename ALL' for the second traces

1) Select profile "TestAllRecursive" in Fetch
Remote Traces wizard (Remote Profile page)
2) Click on 'Next' button (enter password if
needed)

3) Click on 'Finish’

4) In dialog box select 'Overwrite' for the first
trace and 'Overwrite ALL' for the second traces
1) Select profile "TestAllRecursive" in Fetch
Remote Traces wizard (Remote Profile page)
2) Click on 'Next' button (enter password if
needed)

3) Click on 'Finish’

4) In dialog box select 'Skip' for the first trace
and "Skip ALL' for the second traces

1) Select profile "TestAllRecursive" in Fetch
Remote Traces wizard (Remote Profile page)
2) Select checkbox 'Overwrite traces without
warning'

3) Click on 'Next' button (enter password if
needed)

4) Click on 'Finish'

Delete all traces from Traces directory

Verify that all test traces are imported with
correct trace types assigned. Verify that folder
structure is preserved.

All traces deleted

Verify that only the selected traces are
imported with correct trace types assigned.
Verify that folder structure is preserved.

Al traces deleted

Verify that all test traces are imported with
correct trace types assigned (LTTng kernel,
LTTng UST, custom text, custom XML). The
file unrecognized.log is importeds with
unrecognized trace type. Make sure that
directory structure is preserved.

Verify that all test traces are imported with
new name and correct trace types assigned
(LTTng kernel, LTTng UST, custom text,
custom XML). The file unrecognized.log is
importeds with unrecognized trace type.
Make sure that directory structure is
preserved.

Verify that all test traces are imported with
correct trace types assigned where old traces
are overwritten. (LTTng kernel, LTTng UST,
custom text, custom XML). The file
unrecognized.log is importeds with
unrecognized trace type. Make sure that
directory structure is preserved.

Verify that all test traces are skipped and no
trace is imported

Verify that all test traces are imported with
correct trace types assigned where old traces
are overwritten (no dialog box opens). (LTTng
kernel, LTTng UST, custom text, custom
XML). The file unrecognized.log is importeds
with unrecognized trace type. Make sure that
directory structure is preserved.

Al traces deleted

SWTBot
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8.9

8.10

8.1

8.12

8.13

8.14

8.15

Re-run Profile "TestAlIRecursive"
(2)

Clear traces

Run Profile
"TestAlINonRecursive"

Clear traces

Run Profile
"TestSpecificRecursive"
Clear traces

Run Profile
"TestSpecificNonRecursive"
Clear traces

Run Profile
"TestSpecificMutliGroupRecursiv
&

Clear traces

Cancel Import
Clear traces

Run Profile "TestMultiNodes"

Connection Handling

1) Select profile "TestAllRecursive" in Fetch
Remote Traces wizard (Remote Profile page)
2) Click on 'Finish' (enter password if needed)
Delete all traces from Traces directory

1) Select profile "TestAllNonRecursive" in Fetch
Remote Traces wizard (Remote Profile page)
2) Click on 'Next' button (enter password if
needed)

3) Click on 'Finish’

Delete all traces from Traces directory

1) Select profile "TestSpecificRecursive" in Fetch

Remote Traces wizard (Remote Profile page)
2) Click on 'Next' button (enter password if
needed)

3) Click on 'Finish’

Delete all traces from Traces directory

1) Select profile "TestSpecificNonRecursive" in
Fetch Remote Traces wizard (Remote Profile
page)

2) Click on 'Next' button (enter password if
needed)

3) Click on 'Finish’

Delete all traces from Traces directory

1) Select profile
"TestSpecificMultiGroupRecursive" in Fetch
Remote Traces wizard (Remote Profile page)
2) Click on 'Next' button (enter password if
needed)

3) Click on 'Finish’

Delete all traces from Traces directory

1) Select profile "TestAllRecursive" in Fetch
Remote Traces wizard (Remote Profile page)
2) Click on 'Next' button (enter password if
needed)

3) Click on 'Finish’

4) Cancel import (red square or Cancel button)
Delete all traces from Traces directory

1) Select profile "TestMultiNodes" in Fetch
Remote Traces wizard (Remote Profile page)
2) Click on 'Next' button (enter password if
needed)

3) Click on 'Finish’

Verify that all test traces are imported with
correct trace types assigned. The second
page is omitted. (LTTng kernel, LTTng UST,
custom text, custom XML). The file
unrecognized.log is importeds with
unrecognized trace type. Make sure that
directory structure is preserved.

All traces deleted

Verify that only traces from root path are
imported (LTTng kernel, LTTng UST, custom
text, custom XML). The file unrecognized.log
is importeds with unrecognized trace type.
Make sure that directory structure is
preserved.

All traces deleted

Verify that only kernel and custom text/ XML
logs are imported from root and subdirectory.
Make sure that directory structure is
preserved.

All traces deleted

Verify that only kernel and custom text/ XML
logs are imported from root directory only.
Make sure that directory structure is
preserved.

All traces deleted

Verify that only traces from root path are
imported (LTTng kernel, LTTng UST, custom
text, custom XML). Make sure that directory
structure is preserved.

All traces deleted

Verify that import operation is cancelled

All traces deleted

Verify that only traces from root path are
imported (LTTng kernel, LTTng UST, custom
text, custom XML). The file unrecognized.log
is importeds with unrecognized trace type.
Make sure that directory structure is
preserved. 2 nodes directories are created
with the above traces stored

SWTBot
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9.1

9.2

10
10.1

10.2

Error cannot connect to remote
host (node doesn't exist)

Error cannot connect to remote
host (wrong password)

Other Remote Backends
Clear traces

Remote Fetch using SSH

Create profile with IP address that cannot be
connected to and run profile

Create profile with valid IP address. When asked

for password enter invalid password

Delete all traces from Traces directory

Update profile with local username and run test

9.2 entering the correct password

Operation to connect to remote node fails and
error dialog is shown with detailed information
(after time-out)

Operation to connect to remote node fails with

time-out and error dialog is shown with
detailed information. Note time-out is as per
remote development preferences. platform
dependent

All traces deleted

Verify that all test traces are imported with
correct trace types assigned (LTTng kernel,
LTTng UST, custom text, custom XML). The
file unrecognized.log is imported with
unrecognized trace type. Make sure that
directory structure is preserved. Test with
custom parsers from tmf.core.test

SWTBot
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Section
LTTng 2.0 - Control Flow View

Target: Windows

Step Test Case

0

1.2
1.3

Prerequisites
Import traces
Create experiment

View management
Open perspective

Open trace

Open experiment
Close view

Open view

View selection

Select process in table

Select process in time graph

Select state in time graph

Mouse handling

Drag move chart area

Zoom time range (mouse wheel)

Zoom time range (mouse drag)

Mouse vertical scroll

Pass

Action

Import LTTng Kernel traces in Tracing project

Create an experiment with LTTng Kernel
traces

Open and reset LTTng Kernel Perspective

Open Linux Kernel trace in Project Explorer

Open experiment with Linux Kernel traces in
Project Explorer
Close the Control Flow view

Open the Control Flow view
Select a process in the table
Select a process in the time graph (empty

region)

Select a state (A block in the gantt chart) in
the time graph

Ctrl-Drag move time graph left and right with
middle button

Zoom with mouse wheel up and down, cursor
inside time graph while holding the Ctl button

Drag in time graph scale left and right with
left button

Scroll with mouse wheel up and down

Fail

Verification

Control Flow view opens.

Control Flow view is populated with
processes, sorted by Trace then TID. Child
processes appear under their parent, sorted
by birth time. Range is set to initial offset.
Arrows are drawn between states of a CPU.

Control Flow view is populated with
processes, sorted by Trace then TID. Child
processes appear under their parent, sorted
by birth time. Range is set to initial offset.
Arrows are drawn between states of a CPU.
View is closed.

Control Flow view is opened and populated
with processes.

Same process is highlighted in time graph.

Same process is highlighted in table. Selected
time line is updated. Other views are
synchronized to selected time.

Same process is highlighted in table. State is
highlighted in time graph. Selected time line is
updated. Other views are synchronized to
selected time.

Visible range is dragged. When mouse button
is released, states are updated and new time
range is propagated to other views.

Time range is zoomed in and out, relative to
mouse cursor. When mouse wheel is stopped
for a short time, states are updated and new
time range is propagated to other views.

Time range is zoomed in and out. When
mouse button is released, states are updated
and new time range is propagated to other
views.

Table and time graph scroll up and down and

remain aligned. Selected process does not
change. Vertical scroll bar updated.

Automated To Do Comments

Type

Manual

Manual

SWTBot

SWTBot

Manual
SWTBot

SWTBot

SWTBot

Manual

Manual

SWTBot

SWTBot

SWTBot

Manual

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

0

Comment
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3.6

3.7

3.8

3.9

3.1

4.1

4.2

5.1

5.2

5.3

5.4

5.5

5.6

5.7

5.8

Vertical scroll bar

Drag zoom time range

Double-click reset time range

Mouse hover (empty region)

Mouse hover (state)

Drag mouse selection

Shift key selection

Keyboard handling

Keyboard navigation in time graph
(process selection)

Keyboard navigation in time graph
(state selection)

Tool bar handling

Show Legend

Reset Time Scale

Select Previous/Next Event
Select Previous/Next Process
Zoom In/Out

Filter Dialog

Filter Processes

Hide Arrows

Click and drag vertical scroll bar

Drag select time graph with right button

Double-click left button on time scale

Hover mouse in time graph over empty
region

Hover mouse in time graph over state

Drag select time graph with left button

Click select with left button (begin time),
press shift key and click select another time
(end time)

With focus on time graph, use UP, DOWN,
HOME, END keys

With focus on time graph, use LEFT, RIGHT
keys

Click Show Legend button

Click Reset Time Scale button

Click Previous/Next Event button

Click Previous/Next Process button

Click Zoom In/Out button
Open Filter Dialog

1) Open Filter Dialog
2) Deselect several processes
3) Press Ok

Click Hide Arrows button

Table and time graph scroll up and down and
remain aligned. Selected process does not
change.

Selection highlighted. When mouse button is
released, time range is zoomed to selection,
states are updated and new time range is
propagated to other views.

Time range is reset to full range, states are
updated and new time range is propagated to
other views.

Tool tip shows process name only.

Tool tip shows process name, state name,
date, start time, stop time, duration. For
USERMODE state, CPU is shown. For
SYSCALL state, CPU and System Call is
shown. For INTERRUPTED state, CPU is
shown.

Selection highlighted. Status bar of Eclipse is
updated with time information: T, T1, T2 and
delta, where T is the time of the mouse
position, T1 the first selected time, T2 the
second (dragged) selected time and delta the
time difference between T2-T1 (can be

nanatival

Selection highlighted. Status bar of Eclipse is
updated with time information: T, T1, T2 and
delta, where T is the time of the mouse
position, T1 the first selected time, T2 the
second (dragged) selected time and delta the
time difference between T2-T1 (can be
negative)

Selected process is changed. Table selection
is updated. Vertical scroll bar updated.
Previous or next state is selected. Selected
time is updated in other views.

The legend dialog is opened and can be
closed.

Time range is reset to full range, states are
updated and new time range is propagated to
other views.

Previous or next state is selected. Selected
time is updated in other views.

Selected process is changed in table and time
graph. Vertical scroll bar updated.

Time range is zoomed in and out, relative to
center of selection or window. States are
updated and new time range is propagated to

Verify that all buttons are working correctly

Verify that only selected processes are
displayed in the view

Verify that arrows are not drawn in the time
graph

Manual
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Manual

Manual

Manual

SWTBot

Manual

Manual

SWTBot
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SWTBot
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Manual

Manual
SWTBot

SWTBot

Manual



5.9

5.10
5.1

5.12

6.1

6.2

6.3

6.4

71

7.2

7.3

7.4

7.5

7.6
7.7

Follow CPU Forward
Follow CPU Backward
Optimize

Re-Optimize

Go to next event of selected thread
Go to previous event of selected
thread

Synchronization

Time synchronization

Event synchronization

Window range synchronization

Selection range synchronization

Multiple Trace Synchronization

Preparation

Open multiple traces (no overlap)

Change selected time and range
(no overlap)

Select other trace (no overlap)

Open multiple traces (overlap)
Change selected time and range
(overlap)

Select other trace (overlap)
Close all traces

With focus on time graph, click Follow CPU
Forward button

With focus on time graph, click Follow CPU
Backward button
Click on the optimize button

Click on the optimize button a few more times

Select a thread and click on go to next event
of selected thread

Select a thread and click on go to previous
event of selected thread

Select a random time in another view

Select a state-impacting event
(sched_switch, syscall, ...) in events table or
in Resources view using Select
Previous/Next event.

Select a new window range in Resources
view or in Histogram view.

In any other view that supports selection
range synchronization, select a new range.

1) Download traces.zip (if necessary) and
unzip into a local directory ${local}

2) Import kernel trace ${local}
Itraces/import/kernel-overlap-testing

3) Import UST ${local}/traces/import/trace
ust-overlap-testing

Open multiple traces that don't overlap in
time. For each trace, right click on the Events
table and select Follow time update from
other traces

Select a time and new range

Select different trace by clicking its Events
editor tab

Open multiple traces that record events in the
same time range. For each trace, right click
on the Events table and select Follow time
update from other traces

Select a time and new range

Select different trace by clicking its Events
editor tab

Close all Events editor tabs

Time graph is updated to show the next state
for this cpu following the arrow, the event is
selected in the Events editor.

Time graph is updated to show the previous
state for this cpu following the arrow, the
event is selected in the Events editor.

verify that the processes are closer together.
verify that the processes did not move, the
optimization is stable

Verify in the events table that the selected
thread is the same as the previous event
Verify in the events table that the selected
thread is the same as the previous event

Selected time line is updated. If selected time
is outside current range, time range is
updated to include it and view doesn't zoom
out

In addition to updating the selected time, the
process containing the state change is
selected and revealed. Vertical scroll bar is
updated if necessary.

Window range is updated.

Selection is highlighted. If the left time (T1) of
selected time range is outside the current
range, then window range is updated to
include it

View shows the last opened trace

Selected time line and time range is updated
to selected time and new range.

View is updated to show selected trace.
Selected time line and time range are restored
to the selected trace's previously selected
time and range.

View shows the last opened trace

Selected time line and time range is updated
to selected time and new range.

View is updated to show selected trace.
Selected time line and time range are set to
the newly selected time and range.

View is cleared.

SWTBot
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8.1

| Filtering

8.1

8.2

8.3

9.1

9.2

9.3

Preparation

Apply filter (1st trace)

Apply filter (2nd trace)

Persitent filter

Miscellaneous

Restart (Bug 409345)

Select single time (Bug 477009)

Window range synchronization
(Bug 477012)

Open 2 LTTng Kernel Traces

1) Open filter dialog

2) Create filter

3) Click on OK

1) Switch to 2nd trace (keep 1st open)
2) Open filter dialog

3) Create filter

4) Click on OK

Switch between both open traces

1) Open LTTng Kernel Trace

2) Select Control Flow View

3) Restart Eclipse

1) Open LTTng UST trace while CFV is open
2) Select event in events table

1) Open Control Flow view, Resources view
and a kernel trace. Initial window range is
range 1".

2) Go "right one page" on Control Flow view
by pressing right arrow in scroll bar.

3) Go "left one page" on Resources view by
pressing left arrow in scroll bar.

4) Go "right one page" on Control Flow view.

Make sure that only selected processes of
filter dialog are shown

Make sure that only selected processes of
filter dialog are shown

Make sure that previously set filter are still
available

Verify that Control Flow View is populated

Verify that Control Flow View is empty, current
window range stays change to ensure visibility

Verify that after each step the initial window
range doesn't change

Manual
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Section Automated To Do Comments
Critical Path

Target: Windows

Step Test Case Action Verification Type Comment

0 Prerequisites

Import the 3
django traces from

0.1 Import traces the test traces
Create an
experiment with

0.2  Create experiment the 3 traces in it
Synchronize the
experiment, it
should be
accurate and 2 of
the traces will be

0.3  Synchronize experiment  udpated

1 View management
Expand the Views element under the trace.
Open any of the  The OS Execution Graph analysis is there
django traces in and the Critical Flow view is available under
1.1 Open trace Project Explorer it. SWTBot Pass
Expand the Views element under the trace.
The OS Execution Graph analysis is there
Open the django  and "normal”. The Critical Path analysis is
experiment in there and the Critical Flow view is available
1.2 Open experiment Project Explorer  under it. SWTBot Pass
Expand the Views
element, then the
Critical Path
analysis and click
on the Critical
1.3  Open view Flow View Critical Flow view is opened and empty SWTBot Pass
Close the Critical Automation
1.4  Close view Flow View Critical Flow view is closed Manual Pass Candidate




1.5

1.6

2

2.1

2.2

2.3

24

2.5

Unapplicable trace

Unapplicable experiment

View population

Populate the view with
trace

Select worker in time
graph

Select state in time graph

Select worker in tree
viewer

Populate the view with
empty path

Open a trace that
is notan LTTng
kernel trace
Open an
experiment that
does not contain
LTTng kernel
traces

With the django-
client trace and
the critical path
view opened, in
the control flow
view, find the
process named

python (TID 9496).

Right-click on the

process and select

"Follow
python/9496"
Select an empty
region in the time
graph section

Select a state in
the time graph
Select a worker
from the tree
viewer section
Repeat steps of
2.1, with django-
client trace and
process Ittng-
sessiond (TID
9355)

Expand the Views element under the trace.

The OS Execution Graph analysis is not
there.

Expand the Views element under the trace.
The OS Execution Graph analysis is there,
but striked out.

The LTTng kernel exec graph is executed
and at the end, the critical path view shows
the interaction between 3 workers.

Same process is highlighted in table.
Selected time line is updated. Other views
are synchronized to selected time.

Same process is highlighted in table. State
is highlighted in time graph. Selected time
line is updated. Other views are
synchronized to selected time.

Same process is highlighted in time graph.

The Critical Path View is emptied

Manual

Manual

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate
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2.6

2.7

2.8

3.1

3.2

3.3

Select again

Re-opening

Populate the view with
experiment

Populate with trace with
time selection

‘Mouse handling

Drag move time range

Zoom time range (mouse

wheel)

Zoom time range (mouse
drag)

Repeat steps of
2.1, and select
python/9496 again
Close the django-
client trace,
reopen it and
repeat steps of 2.1
Repeat steps of
2.1, but with the
django-experiment
instead

Re-open django-
client trace. In the
Control Flow View,
select a time after
the python
process exited,
then follow the
python/9496
process

Ctrl-Drag move
time graph left and
right with middle
button

Zoom with mouse
wheel up and
down, cursor
inside time graph
while holding the
Ctl button

Drag in time graph
scale left and right
with left button

The critical path should be the same as 2.1

The Critical Path View should be populated
like in step 2.1

The LTTng kernel exec graph is executed
and at the end, the critical path view is
populated with elements from the 3 traces.

The Critical Flow View should be populated
like in step 2.1

Time range is dragged. When mouse button
is released, states are updated and new
time range is propagated to other views.

Time range is zoomed in and out, relative to
mouse cursor. When mouse wheel is
stopped for a short time, states are updated
and new time range is propagated to other
views.

Time range is zoomed in and out. When
mouse button is released, states are
updated and new time range is propagated
to other views.

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate



3.4

3.5

3.6

3.7

3.8

3.9

3.10

3.1

Mouse vertical scroll

Vertical scroll bar

Drag select time range

Double-click reset time
range

Mouse hover (empty
region)

Mouse hover (state)

Drag mouse selection

Shift key selection

'Keyboard handling

Scroll with mouse
wheel up and
down, cursor
outside time graph

Click and drag
vertical scroll bar

Drag select time
graph with right
button
Double-click left
button on time
scale

Hover mouse in
time graph over
empty region
Hover mouse in
time graph over
state

Drag select time
graph with left
button

Click select with
left button (begin
time), press shift
key and click
select another
time (end time)

Table and time graph scroll up and down
and remain aligned. Selected worker does
not change. Vertical scroll bar updated.
Table and time graph scroll up and down
and remain aligned. Selected process does
not change.

Selection highlighted. When mouse button
is released, time range is zoomed to
selection, states are updated and new time
range is propagated to other views.

Time range is reset to full range, states are
updated and new time range is propagated
to other views.

Tool tip shows process name and PID.
[processName, pid] (e.g. [postgres,32554])

Tool tip shows worker name, state name,
priority, date, start time, end time, duration.
Selection highlighted. Status bar of Eclipse
is updated with time information: T, T1, T2
and delta, where T is the time of the mouse
position, T1 the first selected time, T2 the
second (dragged) selected time and delta
the time difference between T2-T1 (can be
negative)

Selection highlighted. Status bar of Eclipse
is updated with time information: T, T1, T2
and delta, where T is the time of the mouse
position, T1 the first selected time, T2 the
second (dragged) selected time and delta
the time difference between T2-T1 (can be
negative)

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate



4.1

4.2

43

4.4

5.1

5.2

5.3

Keyboard navigation in

table (process selection)

Keyboard navigation in
table (tree expansion)

Keyboard navigation in
time graph (process
selection)

Keyboard navigation in
time graph (state
selection)

“Tool bar handling

Align views

Show Legend

Reset Time Scale

With focus on
table, use UP,
DOWN, HOME,
END keys

With focus on
table,

in Windows use
LEFT, RIGHT
keys while trace or
worker is selected

in Linux use
SHIFT LEFT,
RIGHT keys while
trace or worker is
selected

With focus on time
graph, use UP,
DOWN, HOME,
END keys

With focus on time
graph, use LEFT,
RIGHT keys

Click on the Align
View Button, with
another time graph
view, eg the
Control Flow view
opened above or
under

Click Show
Legend button

Click Reset Time
Scale button

Selected process is changed. Time graph
selection is updated. Vertical scroll bar
updated.

For trace, tree is expanded or collapsed.
Time graph item expansion is updated.
Vertical scroll bar updated. For workers, it
does nothing.

Selected worker is changed. Table
selection is updated. Vertical scroll bar
updated.

Previous or next state is selected. Selected
time is updated in other views.

When it is pressed, moving the line
between tree viewer and time graph will
move the line of the other view. If not
pressed, the line can be moved without
affecting the other views

The legend dialog is opened and can be
closed.

Time range is reset to full range, states are
updated and new time range is propagated
to other views.

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

Automation
Candidate

Automation
Candidate

Automation
Candidate
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5.5

5.6

5.7

5.8

5.9

5.1

5.12

6.1

Select Previous/Next
Event

Select Previous/Next
Element

Zoom In/Out

Add Bookmark

Next/Previous marker

Delete bookmark

Do not show markers

Show markers

| Synchronization

Time synchronization

Click
Previous/Next
Event button
Click
Previous/Next
Element button

Click Zoom In/Out

button

Select a time, and

click on the Add
Bookmark button
Add more
bookmarks, then
click on the
next/previous
marker buttons

With next/previous
marker, when on a

bookmark, click
the delete
bookmark button
Click on the down
arrow at the
extreme right of
the view, then
expand Show
markers and
uncheck the
Bookmarks box
Same as above,
recheck the
Bookmarks box

Select a random
time in another
view

Previous or next state is selected. Selected
time is updated in other views.

Selected worker is changed in table and
time graph. Vertical scroll bar updated.
Time range is zoomed in and out, relative to
center of selection or window. States are
updated and new time range is propagated
to other views.

The bookmark is added and is displayed in
the other views as well (if enabled)

The time graph view navigate between the
bookmarks, States are updated and time
selection is propagated to other views.
When on a bookmark, the Add bookmark
buttons changes to Delete bookmark

The bookmark is deleted from all views

All remaining bookmarks disappear from
the view, but remain in other views where
the they are enabled

The bookmarks come back

Selected time line is updated. If selected
time is outside current range, time range is
updated to include it.

SWTBot

SWTBot

SWTBot

SWTBot
SWTBot

SWTBot

SWTBot

SWTBot

it's not updated in other
view

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate



6.2

6.3

6.4

Window range
synchronization

Selection range
synchronization

Out of region selection

Select a new
window range in
another view

In any other view
that supports
selection range
synchronization,
select a new
range.

With a critical path
displayed, select a
time in another
view that is not in
the range of the
process being
displayed in the
critical path view

Window range is updated.

Selection is highlighted. If the left time (T1)
of selected time range is outside the current
range, then window range is updated to
include it

Selected time is updated and the critical
path view is synced with the other

SWTBot

SWTBot

SWTBot

Automation
Candidate

Automation
Candidate

Automation
Candidate



Section
LTTng 2.0 - Resources View

Target: Windows

Step Test Case

0

=y

1.2
1.3

Prerequisites
Import traces
Create experiment
View management

Open perspective

Open trace

Open experiment
Close view

Open view

View selection

Select resource in time graph

Select state in time graph

Mouse handling

Drag move canvas

Zoom time range (mouse wheel)

Zoom time range (mouse drag)

Mouse vertical scroll

Pass

Action

Import LTTng Kernel traces in Tracing project

Create an experiment with LTTng Kernel
traces

Open and reset LTTng Kernel Perspective,
and select Resources view

Open LTTng Kernel trace in Project Explorer

Open experiment with LTTng Kernel traces in
Project Explorer
Close the Resources view

Open the Resources view

Select a resource in the time graph (empty
region)

Select a state in the time graph

Drag move time graph left and right with
middle button

Ctrl+mousewheel in the time graph

Drag in time graph scale left and right with
left button

Scroll with mouse wheel up and down, cursor
outside time graph (in name space)

Fail

Verification

Resource view opens.

Resource view is populated with traces
(sorted by name) and their resources as tree
children (sorted by resource type then
numerically) Range is set to initial offset.

Resource view is populated with traces
(sorted by name) and their resources as tree
children (sorted by resource type then
numerically) Range is set to initial offset.
View is closed.

Resources view is opened and populated with
processes.

Resource is highlighted. Selected time line is
updated. Other views are synchronized to
selected time.

State is highlighted in time graph. Selected
time line is updated. Other views are
synchronized to selected time.

Time range is dragged. When mouse button is
released, states are updated and new window
range is propagated to other views.

Time range is zoomed in and out, relative to
mouse cursor. When mouse wheel is stopped
for a short time, states are updated and new
time range is propagated to other views.

Time range is zoomed in and out. When
mouse button is released, states are updated
and new time range is propagated to other
views.

Time graph scrolls up and down. Selected
process does not change. Vertical scroll bar
updated.

Automated ToDo Comments

16 0
Type
Manual Pass
Manual Pass
SWTBot Pass
SWTBot Pass
Manual Pass
SWTBot Pass
SWTBot Pass
Manual Pass
Manual Pass
SWTBot Pass
Manual Pass
SWTBot Pass
Manual Pass

1

Comment

Automation
Candidate

Automation
Candidate



3.5

3.6

3.7

3.8

3.9

3.10

3.1

4.1

4.2

5.1

5.2

5.3

5.4

5.5

Vertical scroll bar

Drag select time range

Double-click reset time range

Mouse hover (empty region)

Mouse hover (state)

Drag mouse selection

Shift key selection

‘Keyboard handling

Keyboard navigation in time graph
(process selection)

Keyboard navigation in time graph
(state selection)

Tool bar handling

Show Legend

Reset Time Scale
Select Previous/Next Event

Select Previous/Next Process

Zoom In/Out

Click and drag vertical scroll bar

Drag select time graph with right button

Double-click left button on time scale

Hover mouse in time graph over empty
region

Hover mouse in time graph over state

Drag select time graph with left button

Click select with left button (begin time),
press shift key and click select another time
(end time)

With focus on time graph, use UP, DOWN,
HOME, END keys

With focus on time graph, use LEFT, RIGHT
keys

Click Show Legend button

Click Reset Time Scale button
Click Previous/Next State button

Click Previous/Next Resource button

Click Zoom In/Out button

Time graph scroll up and down and remain
aligned. Selected process does not change.

Selection highlighted. When mouse button is
released, time range is zoomed to selection,
states are updated and new time range is
propagated to other views.

Time range is reset to full range, states are
updated and new time range is propagated to
other views.

Tool tip shows resource name only.

Tool tip shows resource name, state name,
date, start time, end time, duration. For IRQ
state, IRQ name is shown. For
INTERRUPT/SOFT_IRQ_ACTIVE state, CPU
is shown.On usermode and syscall tool tip
shows also shows TID and process name. For
syscall the system call name is shown as well
as the kernel callsite (if available).

Selection highlighted. Status bar of Eclipse is
updated with time information: T, T1, T2 and
delta, where T is the time of the mouse
position, T1 the first selected time, T2 the
second (dragged) selected time and delta the
time difference between T2-T1 (can be
negative)

Selection highlighted. Status bar of Eclipse is
updated with time information: T, T1, T2 and
delta, where T is the time of the mouse
position, T1 the first selected time, T2 the
second (dragged) selected time and delta the
time difference between T2-T1 (can be
negative)

Selected process is changed. Vertical scroll
bar updated.

Previous or next state is selected. Selected
time is updated in other views.

The legend dialog is opened and can be
closed.

Time range is reset to full range, states are
updated and new time range is propagated to
other views.

Previous or next state is selected. Selected
time is updated in other views.

Selected resource is changed in time graph.
Vertical scroll bar updated.

Time range is zoomed in and out, relative to
center of selection or window. States are
updated and new time range is propagated to

Manual

Manual

Manual

Manual

Manual

SWTBot

Manual

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

Manual

SWTBot

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

TimeGraphViewTest

TimeGraphViewTest

TimeGraphViewTest

TimeGraphViewTest

Automation
Candidate



5.6  Filter Dialog Open Filter Dialog Verify that all buttons are working correctly SWTBot -
6 Synchronization
Selected time line is updated. If selected time
is outside current range, time range is
6.1  Time synchronization Select a random time in another view updated to include it. Manual
Select a new time range in Control Flow view
6.2  Time range synchronization or in Histogram view. Time range is updated. (window/selection) Manual
Selection is highlighted. If begin time (T1) of
Time range selection In any other view that supports range selected time range is outside the current
6.3  synchronisation synchronization, select a new range. range, then time range is updated to include it Manual
7 Multiple Trace Synchronization
1) Download traces.zip (if necessary) and
unzip into a local directory ${local}
2) Import kernel trace ${local}
ltraces/import/kernel-overlap-testing
3) Import UST ${local}/traces/import/trace
ust-overlap-testing
Preparation 4) Create experiment with trace of 2) in it Manual
Open multiple traces that don't overlap in
time. For each traces, click on the Events View shows the last opened trace. The Follow
table and select Follow time updates from time updates from other traces option in the
7.1 Open multiple traces (no overlap) other traces Context menu of the Events table is selected. Manual
Change selected time and range Selected time line and time range is updated
7.2 (nooverlap) Select a time and new range to selected time and new range. Manual
View is updated to show selected trace.
Selected time line and time range are restored
Select different trace by clicking its Events to the selected trace's previously selected
7.3  Select other trace (no overlap) editor tab time and range. Manual
Open multiple traces that overlap in time.
For each traces, click on the Events table View shows the last opened trace. The Follow
and select Follow time updates from other time updates from other traces option in the
7.4  Open multiple traces (overlap) traces Context menu of the Events table is selected. Manual
Change selected time and range Selected time line and time range is updated
7.5 (overlap) Select a time and new range to selected time and new range. Manual
View is updated to show selected trace.
Select different trace by clicking its Events Selected time line and time range are set to
7.6  Select other trace (overlap) editor tab the newly selected time and range. Manual
7.7  Close all traces Close all Events editor tabs View is cleared. SWTBot
8.1  Filtering [
Preparation Open 2 LTTng Kernel Traces Manual
8.1 Apply filter (1st trace) 1) Open filter dialog Make sure that only selected processes of SWTBot
1) Switch to 2nd trace (keep 1st open)
2) Open filter dialog
3) Create filter Make sure that only selected processes of
8.2  Apply filter (2nd trace) 4) Click on OK filter dialog are shown Manual
Make sure that previously set filter are still
8.3  Persistent filter Switch between both open traces available Manual
9 Miscellaneous
1) Open LTTng Kernel Trace
2) Select Resource View
9.1 Restart (Bug 409345) 3) Restart Eclipse Verify that Resources View is populated Manual

Sehr: It is kind of strange that the filter view has blank
checkboxes for blank lines

TimeGraphViewTest

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate
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Section Pass Fail Automated To Do Comments
Flame Graph View 11 0 0
Target: Ubuntu 20.04.5 64-bit

Step Test Case Action Verification Type Comment
['] Download the test resources Download this
1 Preparation
Verify that
'Flame Graph
Use menu Window — Show View — View' view is

1.1 Open TMF Flame Graph View Tracing — Flame Graph shown SWTBot

Verify that

Import a trace that does not have any call  nothing is
stack information, like a standard kernel shown in the
1.2 Import generic trace trace view SWTBot
Verify that the
Flame Graph
View is
populated with
some
Import the trace in the "trace" directory of  callers/callees
1.3 Import cyg-profile trace the downloaded zip information. SWTBot
Verify that the
Flame Graph
View is
populated with
some
Import a trace in the "trace-fast" directory  callers/callees
1.4  Import cyg-profile-fast trace of the downloaded zip information. SWTBot

2 Manage View
Flame Graph'
view is removed
from
2.1 Close view Close the 'Flame Graph' View perspective SWTBot
Flame Graph'
view is
Use menu Window — Show View — Other displayed and
2.2 Open view ... = Tracing — Flame Graph re-populated SWTBot
Verify that view
is populated
with
callers/callees
2.3 Open Trace Open "trace(-fast)" trace information SWTBot
Verify that view
1) Close 'Flame Graph' view is populated
2) Open "glxgears-cyg-profile(-fast)" trace  with
located in the git in ctf test callers/callees
2.4  Open view when trace is already loaded 3) Open 'Flame Graph' view information SWTBot
Verify that view
is populated
with all
callers/callees
Open Experiment with 2 or more Flame information Automation Candidate

) Graph traces. (separated by Kyrollos: when mapping symbols for a trace in an
2.5 Open Experiment (You can use both traces) trace). Manual experiment both traces in the experiment got mapped


https://drive.google.com/file/d/0BxUCnNTRLr5pWUdXd0JJV3hyeEk/edit?usp=sharing

2.6

27

3.1

3.2

4.1

4.2

4.3

5

Restart

Close all traces

Sorting

Thread name sorting

Thead id sorting

. Synchronization

Time synchronization

Go to maximum

Go to minimum

'Function name import

Restart Eclipse with Flame Graph trace

opened

Close traces and experiment one by one

from the editor tab

Open a trace multiple Flame Graph thread
or open experiment with 2 or more Flame
Graph traces. Then select 'Sort threads by

thread name'

Open a trace multiple Flame Graph thread
or open experiment with 2 or moreFlame
Graph traces. Then select 'Sort threads by

thread id'

Select a random time in another view

1. Open the 'flame chart' View
2. In the 'Flame Graph' view, right-click on

a random entry in the graph
3. Select 'go to maximum'

1. Open the ‘flame chart' View
2. In the 'Flame Graph' view, right-click on

a random entry in the graph
3. Select 'go to minimum’

Verify that view

is populated

with

callers/callees

from trace Manual
Verify that

Flame Graph

view is cleared

after closing the

last trace Manual

The view is
sorted by thread
name. Manual

The view is
sorted by thread
id. Manual

Selected time

line is not

updating.

Nothing

happen. Manual
- The 'flame

chart' view is

populated

- The flame

chart view is

synchronised to

the range of the

maximum call

duration of the

'Flame Graph'

selected entry Manual
- The 'flame

chart' view is

populated

- The flame

chart view is

synchronised to

the range of the

minimum call

duration of the

'Flame Graph'

selected entry Manual

Automation Candidate

Automation Candidate

Kyrollos: | don't know how to evaluate this since |
don't have the process id neither the thread name
in the tooltip but it seems not working

Automation Candidate

Automation Candidate

Automation Candidate

Automation Candidate



5.1

5.1

52

Function name import

‘Mouse handling

Mouse hover (empty region)

Mouse hover (state)

1. Open the 'Call Stack' view with the
'Flame Graph' view and the cyg-profile
trace opened

2. Import 'cyg-profile-mapping.txt' as
mapping text file

Hover mouse in time graph over empty
region

Hover mouse in time graph over state

Both 'Call Stack'
and 'Flame
Graph' views
display function
name instead of
function

address. SWTBot

Tool tip shows
depth only
Tool tip shows
Total time and
self times with
standard
statistics.

SWTBot

SWTBot



Section Pass Fail
GDB Tracing 25

Target: Windows

Automated To Do Comments

4

Comment
extract it. The tra

Step Test Case Action Verification Type
et the trace file here https://drive.qgoogle.com/file/d/1rnfAgFaraG OVcH0-36IMSoM3Q7S/view?usp=sh
1 Preparation
1.1  Step1 Open and reset the GDB Trace perspective GDB Trace perspective opens with correct views ~ Manual
1.2 Step2 Open Navigator View (used for independent verification) Navigator View opens Manual
2 Project Creation
2.1 New Project Wizard Open New Tracing Project Wizard Tracing Project Wizard opens SWTBot
2.2  Create project Specify a project name and finish Tracing project appears in Project Explorer SWTBot
2.3 Project structure Close and open the new Tracing project Project contains the Traces folder SWTBot
3 Traces Folder
3.1 Traces Folder menu Select the Traces folder and open its context menu Correct menu opens (Open Trace, Import, New SWTBot
3.2  Trace Import Wizard Select Import Trace Trace Import Wizard appears SWTBot
3.3 Import traces Select a GDB Trace from samples directory and finish Imported traces appear in Folders with proper Manual
4 Trace Configuration
Verify that an Error Dialog opens that notfiies the
4.1  Project/executable selection Double-click on an un-configured trace user to select the trace executable Manual
1) Right mouse click on trace
2) Select menu item "Select Trace Executable” Trace is configured (4.3 is successful, when 4.2
4.2  Select Trace Executable 3) Fill in the proper values in dialog and finish was successful) Manual
4.3  Open configured trace Double-click on a configured trace Trace is opened, events table and views are Manual
5 Source Code Lookup
The corresponding source code location is
5.1 Select event With mouse select an event in events table selected in the source code file. Manual
The corresponding source code location is
5.2  Select another event redo 5.1 selected in the source code file. Manual
6 Events Table Navigation
Each keystroke modifies the selected event and
6.1 Arrow keys Update the current event using up/down keys within wind the corresponding source code location is SWTBot
Table is refreshed to display new current event
and the corresponding source code location is
6.2  Scrolling Update the current event using up/down keys outside win selected in the source code file SWTBot
6.3  PgUp/PgDn Update the current event using PgUp/PgDn keys Table is scrolled accordingly SWTBot
Table jumps from first to last event and the
6.4 Home/End Update the current event using Home/End keys corresponding source code location is selected SWTBot
7 Events Searching & Filtering
7.1 Search In the search bar, enter some RE Events corresponding to the RE are highlighted SWTBot
7.2 Navigation Navigate through highlighted events using Enter/Shift-Ent Next/previous highlighted event selected SWTBot
7.3  Un-search In the search bar, clear the RE Events are displayed normally SWTBot
7.4  Filter In the search bar, enter some RE and press Ctrl+Enter  Only events matching RE are displayed SWTBot
7.5  Filter & Search In the filter bar, enter some RE; likewise in the search bar Events are filtered and highlighted accordingly SWTBot
7.6 Un-filter In the filter header, remove the filter Events are displayed normally SWTBot
8 Events Synchronization
8.1 Synch from Events View Click on an event in the Events View Trace Control View is updated; Debug View is Manual
8.2  Synch from Trace Control Go up/down from the Trace Control View Events View is updated accordingly Manual

Pass
Pass
Pass

Pass
Pass
Pass

Pass

Pass
Pass

Pass

Pass

Pass

Pass
Pass

Pass

Pass
Pass
Pass
Pass
Pass
Pass

Pass
H

Tested in base
class

Tested in base
class
Tested in base

Tested in base
class



Section Pass Fail Automated To Do Comments
Tracing RCP 34 | o [ o |1
Target: Windows Tested using kernel_vm in traces.zip

Step Test Case Action Verification Type Comment

0 Preparation

1 Start RCP

1.1 Start Tracing RCP Open RCP from command line or file explorer Tracing RCP opens in default perspective Manual Pass
Start Tracing RCP with text Open RCP from command line with --open <trace name with

1.2 trace absolute path> Trace will be opened with auto-detected trace type Manual Pass
Start Tracing RCP with Open RCP from command line with --open <trace name with Verify that the same trace that was previously linked into the Traces folder

1.3  previously opened text trace absolute path>. Use same trace than 1.2 is opened and not a new trace entry is created Manual Pass
Start Tracing RCP with Kernel Open RCP from command line with --open <kernel trace name Tracing RCP is opened, the trace is linked to the Tracing project, the

1.4  CTF trace with absolute path> kernel analysis trace type is selected and trace is opened. Manual Pass

Start Tracing RCP with
previously opened Kernel CTF Open RCP from command line with --open <kernel trace name Verify that the same trace that was previously linked into the Traces folder

1.5 trace with absolute path>. Use same trace than 1.4 is opened and not a new trace entry is created Manual Pass
Open RCP from command line with --open <trace name with Verify that a new trace is linked to the Tracing project and trace is
Start Tracing RCP with new absolute path>, where the name of trace is the same than 1.2, but opened. Verify that the new trace name has a integer number in braces as
1.6  trace with name conflict the trace is located at a different location on disk suffix added. Manual Pass
Open RCP from command line with --open <kernel trace with Verify that a kernel trace is linked to the Tracing project, the kernel
absolute path>, where name of trace is the same than 1.4, but the analysis trace type is selected and trace is opened. Verify that the new
1.7 Re-do 1.6 trace is located at a different location on disk trace name has a integer number in braces a suffix added. Manual Pass

Start Tracing RCP with non-

1.8 tracefile Open file that is not a trace Trace is imported (linked) however default icon (from Eclipse) is set Manual Pass
2 File menu
Use Menu "File -> Open Trace ..." In the file dialog select a text
2.1 Open Trace (File) trace and select open. Trace will be opened with auto-detected trace type Manual Pass
Open Trace (File) with Use Menu "File -> Open Trace...". In the file dialog select a text ~ Verify that the same trace that was previously linked into the Traces folder
2.2  previously opened text trace trace and select open. Use same trace than 2.1 is opened and not a new trace entry is created Manual Pass
Use "Menu File -> Open Trace ..." . In the file dialog select a file  Verify that the trace is linked to the Tracing project, the kernel analysis
2.3  Open Trace (Directory) of Kernel CTF trace directory and select open. trace type is selected and trace is opened. Manual Pass
Open Trace (Directory) with Use "Menu File -> Open Trace ..." . In the file dialog select a file
previously opened Kernel CTF of Kernel CTF trace directory and select open. Use same trace Verify that the same trace that was previously linked into the Traces folder
24 trace than 2.3 is opened and not a new trace entry is created Manual Pass

Use Menu "File -> Open Trace ..." In the file dialog select a text ~ Verify that the new trace is linked to the Tracing project and the trace is

Open Trace File with name trace and select open, where the name of trace is the same than  opened. Verify that the new trace name has an integer number in braces
2.5 conflict 2.1, but the trace is located at a different location on disk as suffix added. Manual Pass
Use "Menu File -> Open Trace ..." . In the file dialog select a file

of Kernel CTF trace directory and select open, where the name of Verify that the kernel trace is linked to the Tracing project, the kernel
trace is the same than 2.3, but the trace is located at a different analysis trace type is selected and trace is opened. Verify that the new
26 Re-do25 location on disk trace name has an integer number in braces as suffix added. Manual Pass

2.7  Open file Open file that is not a trace Trace is imported (linked) however default icon (from Eclipse) is set Manual Pass




2.8
29

3.1

3.2

34

35

441

4.2

4.4

6.1

71

Restart
Exit

Window Menu
Open Perspective
Open View
Preferences

Save Perspective As

Reset Perspective

Help Menu

Help Contents

Help Contents (shortcut)

Install new Software

About

Version + Copyright

Content

TMF presence

LTTng presence

Network Tracing presence

OS Tracing Overview presence

BTF presence

Upgrade

Upgrade from previous release

Add-ons
Install Incubator Software

Use Menu File -> Restart
Use Menu File -> Exit

Use Menu Window -> Show Perspective -> Tracing Perspective
Use Menu Window -> Show View -> Tracing -> Sequence
Diagram

Use Menu Window -> Preferences

Make changes of perspective by moving views and use menu
Window -> Save Perspective As. Enter a perspective name and
select Ok

Make changes of perspective by moving views and use menu
Window -> Reset Perspective.

Use Menu -> Help -> Help Contents
Use key F1

Use Menu -> Help -> Install New Software... to install new Eclipse
feature

Use Menu -> Help -> About

Use Menu -> Help -> About -> Installation details

Open Tracing perspective

Open LTTng Kernel perspective and kernel trace

Open Network Tracing perspective and PCAP trace
Open OS Tracing Overview perspective and kernel trace
Open BTF trace

Use Help -> Check For Updates

Use Menu -> Tools -> Add-ons... to install incubator features (e.g.

Verify that RCP is restarted with the previously open perspective and trace
Tracing RCP exits

Tracing perspective is opened

Sequence diagram view is shown
Preferences dialog is shown

Perspective with new name is stored

After confirming the reset operation the perspective is reset to the default
layout.

Help content browser is opened. All Tracing related help is included
Help content browser is opened. All Tracing related help is included

Installation is successful

About dialog is opened all relevent information (e.g. version, copyright
years etc) is up-to-date and correct.

Go over all tracing features and verify that all have the correct version and
copyright years

Tracing perspective opens

LTTng Kernel perspective opens

Network Tracing perspective opens

OS Tracing Overview perspective opens

Trace type detected and event table has BTF columns

RCP is upgraded. To test before the release at RC1 change update site in
preference to stable update site: e.g. https://download.eclipse.
org/tracecompass/2022-12/stable/rcp-repository

Installation is successful and feature is available. A dialog is shown.

Manual
Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual
Manual
Manual
Manual
Manual

Manual

Manual

Resetting the perspective adds "Run" and
"Search" menus to the main menu. Bug
564009.

Sehr: Bug remains



Section
LTTng 2.0 - Memory Analysis

Target: Windows

Step Test Case

0

0.3
0.4

-

2.2
23

24
25

Prerequisites

Download traces

Import trace with memory event

Import trace without memory event
Import non-UST trace

Project View

Check analysis can execute

Verify help message when applicable

Check analysis cannot execute

Verify help message when not applicable

Check analysis for another trace type

View Management

Populate analysis's view

Open view

Close trace

Open trace
Close view

Re-open view

Mouse handling

Pass

Action

Download UST trace with memory events
from https://secretaire.dorsal.polymtl.
ca/~gbastien/traces/eclipse_mem_ust.tar.
gz. Hung: | suggest downloading eclipse
trace

Import the LTTng UST trace downloaded
above in Tracing project

Import one of the LTTng UST trace that
does not contain the memory events, for
example, the one used for the callstack view

Import one LTTng Kernel trace

open the trace that contains the memory
events. In the project explorer, expand the
trace that contains the memory events

In the project explorer, open and expand
the trace that contains the memory events,
right-click the memory analysis and select
Help

open the trace that does not contain the
memory events. In the project explorer,
expand the UST trace that does not contain
memory events

In the project explorer, open and expand
the UST trace that does not contain memory
events, right-click the memory analysis and
select Help

In the project explorer, expand a LTTng
Kernel trace

Open the UST trace with memory events
and expand the "UST Memory" analysis in
the project explorer

Double-click the UST Memory View under
the memory analysis

Close the trace

With the view already opened, open the
trace

Close the UST Memory Usage view
Double-click the UST Memory Usage view
under the UST memory analysis in project
explorer.

Fail

Verification

"Ust Memory" analysis is present and "normal"

A generic help message appears with the name of the
analysis.

"Ust Memory" analysis is present, but striked-out

The help message mentions the analysis is impossible
to execute and contains the requirement that is not
fulfilled

"Ust Memory" analysis is not present

"Ust Memory Usage" View appears under the analysis
The UST Memory Usage view opens and triggers the
memory analysis. After the analysis, the XY chart is
populated

The UST Memory Usage view is emptied.

The UST Memory Usage view is populated.
The view is closed.

The view opens and is automatically populated.

Automated To Do Comments

8 0
Type
SWTBot Pass
SWTBot Pass
Manual Pass
Manual Pass
SWTBot Pass
SWTBot Pass
SWTBot Pass
Manual Pass
SWTBot Pass
SWTBot Pass
Manual Pass

0

Comment

Automation
Candidate

Automation
Candidate



3.1

3.2

3.3

34

3.5

3.6

3.7

3.8

4.1

4.2

4.3

Drag move time range

Zoom time range (mouse wheel)

Drag select time range
Mouse hover

Drag mouse selection

Shift key selection

Drag mouse selection (Status bar)

Shift key selection (Status bar)

Synchronization

Preparation

Time synchronization
Time range synchronization

Time range selection synchronisation

Drag move xy chart left and right with
middle button

Zoom with CTL + mouse wheel up and
down, cursor inside xy chart

Drag select time graph with right button
Hover mouse in xy chart anywhere

Drag select xy chart with left button
Click select with left button (begin time),

press shift key and click select another time

(end time)

Drag select xy chart with left button

Click select with left button (begin time),

press shift key and click select another time

(end time)

Have the Histogram and UST Memory
Usage views both visible

Select a random time in another view
Select a new time range in UST Memory
Usage view or in Histogram view.

In any other view that supports range
synchronization, select a new range.

Time range is dragged. When mouse button is
released, the view refreshes with the new time range
Time range is zoomed in and out, relative to mouse
cursor. When mouse wheel is stopped for a short time,
series are updated and new time range is propagated
to other views.

Selection highlighted. When mouse button is released,
time range is zoomed to selection, series are updated
and new time range is propagated to other views.

Tool tip shows values for each thread at the given
timestamp

Selection highlighted. New selection is propagated to
other views

Selection highlighted. New selection is propagated to
other views

Selection highlighted. Status bar of Eclipse is updated
with time information: T, T1, T2 and delta, where T is
the time of the mouse position, T1 the first selected
time, T2 the second (draggged) selected time and
delta the time difference between T2-T1 (can be
negative)

Selection highlighted. Status bar of Eclipse is updated
with time information: T, T1, T2 and delta, where T is
the time of the mouse position, T1 the first selected
time, T2 the second (draggged) selected time and
delta the time difference between T2-T1 (can be
negative)

Selected time line is updated.
Time range is updated.

Selection range is highlighted.

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

SWTBot

Manual

Manual

Manual

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate



Target: Windows

Step Test Case

0

0.1

1

1.1

1.2

1.5

2

21

2.2
2.3

24
2.5

2.6

3.1

3.2

4

4.1

LTTng 2.0 - CPU Analysis

Automated

To Do

Prerequisites
Import LTTng Kernel traces in
Tracing project

In the project explorer and expand a
LTTng Kernel trace

In the project explorer, open and
expand the LTTng kernel trace, right-
click the CPU usage analysis and
Verify help message when applicable select Help

"CPU usage" analysis is present

Check analysis can execute and it's not crossed out

A generic help message appears
with the name of the analysis

In the project explorer, expand a non- "CPU usage" analysis is not
Check analysis for another trace type LTTng Kernel trace

View Management

Open an LTTng kernel trace and
expand the "CPU usage" analysis in
the project explorer

"CPU Usage" View appears under
Populate analysis's view
The CPU usage Usage view opens
and triggers the cpu analysis. After
the analysis, both tree viewer and
xy charts are populated.

The CPU Usage view is emptied.

Double-click the CPU usage View
under the CPU usage analysis
Close the trace

With the view already opened, open
The CPU Usage view is populated.
Close the CPU Usage view The view is closed.
Double-click the CPU Usage view
under the CPU usage analysis in
project explorer.

The view opens and is
automatically populated.

View selection
A new series is added to the xy
Select an entry in the tree viewer chart, corresponding to the

Select an entry

A new series is added to the xy
chart, and the previous TID's
series is not displayed anymore

Select another entry from the tree
Select another entry

Mouse handling
Time range is dragged. When

Drag move xy chart left and right with Mouse button is released, series

Drag move time range middle button and shift mouse wheel are updated and new time range is

Type

SWTBot

SWTBot

SWTBot

Manual

SWTBot
Manual

SWTBot
SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Christophe: not sure | understand. Multiple series can
be selected; when selecting a 2nd series, the first one is

Simon: | think this is old and refers to an older view.
With the new tree view the behavior is as you described




4.2

4.3

4.4

4.5

4.6

4.7

4.8

4.9

4.10

Zoom time range (mouse wheel)

Mouse vertical scroll

Vertical scroll bar

Drag select time range

Mouse hover

Drag mouse selection

Shift key selection

Sort columns

Drag mouse selection (Status bar)

Zoom with ctrl mouse wheel up and
down, cursor inside xy chart

Scroll with mouse wheel up and
down, cursor outside xy chart

Click and drag vertical scroll bar

Drag select time graph with right
button in xy chart

Hover mouse in xy chart region
anywhere

Drag select xy chart with left button

Click select with left button (begin
time), press shift key and click select
another time (end time)

Click on column headers of tree
viewer once then twice

Drag select xy chart with left button

Time range is zoomed in and out,
relative to mouse cursor. When
mouse wheel is stopped for a short
time, series are updated and new
time range is propagated to other

viauie inaliidina tha tran
Table scroll up and down. Selected
process does not change. Vertical
scroll bar updated.

Tree viewer scrolls up and down.
Selected process does not change.
Selection highlighted. When
mouse button is released, time
range is zoomed to selection,
series are updated and new time

Tool tip shows the totaland
selected process (if any) cpu

Selection highlighted and selection
range is propagated to other views

Selection highlighted and selection
range is propagated to other views

Entries are sorted in ascending
then descending order on the
column value. Selected process
does not change.

Selection highlighted. Status bar of
Eclipse is updated with time
information: T, T1, T2 and delta,
where T is the time of the mouse
position, T1 the first selected time,
T2 the second (draggged) selected
time and delta the time difference
between T2-T1 (can be negative)

SWTBot

Manual

Manual

SWTBot

Manual

SWTBot

Manual

Manual

Manual




4.11

5.1

6.1

6.2

6.3
6.4

Shift key selection (Status bar)

'Keyboard handling

Keyboard navigation in tree viewer

Synchronization

Time synchronization

Time range synchronization

Time range selection synchronisation
CPU usage works with experiments

Click select with left button (begin
time), press shift key and click select
another time (end time)

With focus on table, use UP, DOWN,
HOME, END keys

Select a random time in another view
Select a new time range in CPU
usage view or in Histogram view.

In any other view that supports range
synchronization, select a new range.

Selection highlighted. Status bar of
Eclipse is updated with time
information: T, T1, T2 and delta,
where T is the time of the mouse
position, T1 the first selected time,
T2 the second (draggged) selected
time and delta the time difference
between T2-T1 (can be negative)

Selected process in table is
changed. Vertical scroll bar
updated.

Selected time line is updated. If
selected time is outside current
range, time range is updated to
include it.

Time range is updated.

Selection is highlighted. If the most
left time (T1) of selected time
range is outside the current range,
then time range is updated to
include it

Manual

Manual

Manual

Manual

Manual
Manual




Section
XML Analysis

Target: Windows

Step Test Case

0
0.1
0.2

0.3

1.2

1.3

1.4

1.5

2

2.1

2.2

23
24

25
2.6

2.7
2.8
2.9

3
3.1

Prerequisites
Import traces
Get a test XML file

Make sure the XML file

Pass

Action

Import LTTng kernel traces

Download the test XML file from the incubator
Open the Manage Xml Analyses menu and delete
the XML file if it exists (or The XML files are
located in <workspace directory>/.metadata/.
plugins/org.eclipse.tracecompass.tmf.analysis.
xml.core/xml_files. Delete the linux kernel XML

does not exist in the project file if it exists.)

XML file handling

Verify analysis not present

Import XML file

Edit XML file

Disable XML file

Enable XML file

View management

Populate the views

In the project Explorer, expand any LTTng kernel
trace

Right-click the Traces folder, select Manage XML
analyses.... In the opened dialog import the
Kernel.Linux.xml file and close the dialog.
Right-click the Traces folder, select Manage XML
analyses.... In the opened dialog, select Kernel.
Linux and click Edit

Right-click the Traces folder, select Manage XML
analyses.... In the opened dialog, click on the
checkbox next to Kernel.Linux to disable it and
click Apply.

Right-click the Traces folder, select Manage XML
analyses.... In the opened dialog, click on the
checkbox next to Kernel.Linux to enable it and
click Apply.

Open an LTTng kernel trace (eg trace2 from the
tracecompass-test-traces repo)

Open the 'Xml Control Flow Double-click the "Xml Control Flow View' under

View'

Open another XML view

Close view

Open view when trace is
already loaded

Close traces

Open trace
Open another trace

Open LTTng Kernel trace

View selection

Select an entry in the table

the analysis

Double-click the "Xml Resources View' under the
analysis

Close both XML views

Double-click one of the views under the analysis
Close all opened traces

Open an LTTng Kernel trace
Open a non-LTTng Kernel trace

Open an LTTng Kernel trace

Select an entry in the table

Fail

Verification

NOTE: XML files haven't been updated to latest Kernel tracepoints and
syscall changes. So, they only work with trace LTTng 2.5 and older

Verify that there is no 'Xml kernel State System' analysis

Verify that the "Xml kernel State System' analysis is now
present under an LTTng kernel trace

Verify that the XML editor opens. The editor should have
Design and Source sub-tabs

Verify that the 'Xml kernel State System' analysis doesn't
show anymore under the LTTng kernel trace

Verify that the 'Xml kernel State System' analysis is present
again under the LTTng kernel trace

The 'Xml kernel State System' analysis should have a +
next to it, expand it and there should be 2 views under it:
'Xml Control Flow View' and 'Xml Resources View'

A view titled 'Xml Control Flow View' should open and it
should look quite similar to the Control Flow View

A view titled 'Xml Resources View' should open and it
should look quite similar to the Resources view's CPU
entries. Both XML views are opened.

The views are closed.

The view opens with the correct title and is correctly
populated.

The view is emptied.

The view is populated.
The view is emptied.

The view is populated.

Same entry is highlighted in time graph.

Automated To Do
10 0
Type
Manual Pass
SWTBot Pass
SWTBot Pass
Manual Pass
Manual Pass
SWTBot Pass
SWTBot Pass
Manual Pass
SWTBot Pass
Manual Pass
SWTBot Pass
Manual Pass
Manual Pass
Manual Pass

Manual Pass

Comments
1

Comment

Automation
Candidate

Automation
Candidate

Automation
Candidate
Automation
Candidate

Automation
Candidate

Automation
Candidate
Automation
Candidate
Automation
Candidate

Automation
Candidate



3.1

2.3

4.1

4.2

4.3

44

4.5

4.6

4.7

4.8

4.9

4.10

4.1

5.1

5.2

5.4

5.4

Select entry in time graph

Select state in time graph

Mouse handling

Drag move time range

Zoom time range (mouse
wheel)

Zoom time range (mouse
drag)

Mouse vertical scroll
Vertical scroll bar

Drag select time range
Double-click reset time
range

Mouse hover (empty
region)

Mouse hover (state)

Drag mouse selection

Shift key selection

Keyboard handling
Keyboard navigation in
table (entry selection)

Keyboard navigation in
table (tree expansion)

Keyboard navigation in time

graph (process selection)

Keyboard navigation in time

graph (state selection)

Tool bar handling

Select an entry in the time graph (empty region)

Select a state in the time graph

Drag move time graph left and right with middle
button

Zoom with CTRL + mouse wheel up and down,
cursor inside time graph

Drag in time graph scale left and right with left
button

Scroll with mouse wheel up and down, cursor
outside time graph

Click and drag vertical scroll bar

Drag select time graph with right button
Double-click left button on time scale
Hover mouse in time graph over empty region

Hover mouse in time graph over state

Drag select time graph with left button

Click select with left button (begin time), press
shift key and click select another time (end time)

With focus on table, use UP, DOWN, HOME,
END keys

With focus on table,

in Windows use LEFT, RIGHT keys while parent
or child process is selected

in Linux use press ENTER while parent or child
process is selected

With focus on time graph, use UP, DOWN,
HOME, END keys

With focus on time graph, use LEFT, RIGHT keys

Same entry is highlighted in table. Selected time line is
updated. Other views are synchronized to selected time.

Same entry is highlighted in table. State is highlighted in
time graph. Selected time line is updated. Other views are
synchronized to selected time.

Time range is dragged. When mouse button is released,
states are updated and new time range is propagated to
other views.

Time range is zoomed in and out, relative to mouse cursor.
When mouse wheel is stopped for a short time, states are
updated and new time range is propagated to other views.
Time range is zoomed in and out. When mouse button is
released, states are updated and new time range is
propagated to other views.

Table and time graph scroll up and down and remain
aligned. Selected entry does not change. Vertical scroll bar
updated.

Table and time graph scroll up and down and remain
aligned. Selected entry does not change.

Selection highlighted. When mouse button is released, time
range is zoomed to selection, states are updated and new
time range is propagated to other views.

Time range is reset to full range, states are updated and
new time range is propagated to other views.

Tool tip shows entry name only.

Tool tip shows entry name, state name, date, start time,
end time, duration.

Selection highlighted. Status bar of Eclipse is updated with
time information: T, T1, T2 and delta, where T is the time of
the mouse position, T1 the first selected time, T2 the
second (draggged) selected time and delta the time
difference between T2-T1 (can be negative)

Selection highlighted. Status bar of Eclipse is updated with
time information: T, T1, T2 and delta, where T is the time of
the mouse position, T1 the first selected time, T2 the
second (draggged) selected time and delta the time
difference between T2-T1 (can be negative)

Selected process is changed. Time graph selection is
updated. Vertical scroll bar updated.

For parent process, tree is expanded or collapsed. Time
graph item expansion is updated. Vertical scroll bar
updated. For child process, left changes selection to
parent, time graph selection is updated. Vertical scroll bar
updated. NOTE: XML files define the trees in the view and
kernel.linux makes it a tree of depth 1

Selected process is changed. Table selection is updated.
Vertical scroll bar updated.

Previous or next state is selected. Selected time is updated
in other views.

Manual

Manual

SWTBot

Manual

SWTBot

Manual

Manual

SWTBot

Manual

Manual

Manual

SWTBot

Manual

Manual

Manual

Manual

Manual

Could not do this test because the trace isn't big

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate



6.1

6.2

6.3

6.4

6.5
6.6

6.7

71

7.2

7.3

Show Legend
Reset Time Scale
Select Previous/Next Event

Select Previous/Next
Process

Zoom In/Out

Filter Dialog

Filter Processes

Synchronization
Time synchronization
Time range synchronization

Time range selection
synchronisation

Click Show Legend button
Click Reset Time Scale button
Click Previous/Next State button

Click Previous/Next interval button

Click Zoom In/Out button

Open Filter Dialog

1) Open Filter Dialog

2) Deselect several processes
3) Press Ok

Select a random time in another view
Select a new time range in Resources view or in
Histogram view.

In any other view that supports range
synchronization, select a new range.

The legend dialog is opened and can be closed.

Time range is reset to full range, states are updated and
new time range is propagated to other views.

Previous or next state is selected. Selected time is updated
in other views.

Selected interval (process/resource) is changed in table
and time graph. Vertical scroll bar updated.

Time range is zoomed in and out, relative to center of time
range. States are updated and new time range is
propagated to other views.

Verify that all buttons are working correctly

Verify that only selected entries are displayed in the view

Selected time line is updated. If selected time is outside
current range, time range is updated to include it.

Time range is updated.

Selection is highlighted. If begin time (T1) of selected time
range is outside the current range, then time range is
updated to include it

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Automation
Candidate

Automation
Candidate
Automation
Candidate

Automation
Candidate

Automation
Candidate
Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate



Section
Trace Synchronization

Target: Windows

Step Test Case

0

0.1

0.2
0.3

-

1.1

1.2

1.3

1.4

1.5

1.6

Prerequisites
Import traces

Create experiment 1
Create experiment 2

View Management
Open Synchronization
View

Delete view

Open view

Open Experiment

Synchronize experiment

Pass
16

Action

Import the scp_dest and scp_src traces in

the synctraces.tar.gz file

Create an experiment containing those 2

traces

Create an experiment with any other trace

Use menu Window — Show View — Tracing

— Synchronization

Close the Synchronization View

Use menu Window — Show View — Tracing

— Synchronization

Open the experiment containing the 2

synchronizable traces

Right-click on the experiment and select

'Synchronize Traces'
1) Close Synchronization View

Open view when trace is 2) Load LTTng experiment

already loaded

Synchronize experiment

1.6.5 with constant offset

1.7

1.8

1.9

Open trace

Re-open experiment

Restart
Functionnalities
Open experiment 2

Go back to previous
experiment

Synchronize experiment

3) Open 'Synchronization' view

Try to offset a trace by a second

Open an Lttng Kernel trace

Open the experiment containing the 2

synchronized traces

Restart Eclipse

Open the experiment containing traces that

do not synchronize

Re-open the experiment with the
synchronizable traces

Right-click on the experiment and select

'Synchronize traces'

Fail

Verification

Verify that 'Synchronization'
view is shown
Synchronization' view is
removed from perspective
Synchronization' view is
displayed and remains empty
Verify that the view is still
empty

After a time, the view is
populated with synchronization
result that say 'accurate'’. And
one of the original traces has
been replace by a trace with
the same name, but with an
at the end.

Verify that view is populated
with synchronization data from
currently opened experiment
Visually verify that a
synchronized trace is now
offsetted

Synchronization view is empty
View shows synchronization
data from the experiment
Verify that view is populated
with synchronization data from
experiment

Verify that the 'Synchronization’
view is empty

Verify that the 'Synchronization’
view contains the data from the
experiment

After the syncronization job
finishes, the synchronized
experiment is closed and
experiment 2 is selected. The
synchronization view is empty.

Automated To Do Comments

Type

Manual

Manual
Manual

Manual
Manual
Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

0

Comment

Automation
Candidate

Automation
Candidate
Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate
Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

Automation
Candidate

It's in the test traces now!

Simon: not sure what should be the result of this operation
Bernd: | think it is to add a manual time offset on top of the synchronisation



Section
Network Trace Analysis

Target: Windows

Step Test Case

0
0.1

1

Prerequisites
Import traces

Trace Import
Open the Network Tracing
perspective

Open trace

View management
Populate the views

Look up stream
Close the trace
Close view

Open view when trace is
already loaded

Open a non pcap trace

Stream List
Re-open trace

Create a filter from the
stream list

Apply filter

Pass

Action

Import the trace linked here

In the project Explorer, expand any pcap trace

Double-click on the "TeamSpeak2.pcap" trace

Open the "TeamSpeak2.pcap”
Open the Stream List view

Close the trace
Close the Stream List view

Re-open the trace. Open the Stream List view

Open a non pcap trace

Open "TeamSpeak2.pcap" trace and open
Stream list view

Right click on stream 0, and select "Extract as
Filter"

In the events table, right click on an event and
select "Apply preset filter-> stream eth 00:0c:
29.."

Fail

Verification

Verify that the events view, the properties and
stream list are displayed

The trace is given a "network" icon. When opened,
the events view and stream list view are populated.

The views are updated

One stream is available with endpoint A being 00:0c:

29:7c:ab:f9

The stream list is emptied

The view is closed

The view opens with the correct title and is correctly
populated.

The stream list is emptied

Stream list view populated
A filter named "FILTER stream eth 00:0c:29..." is
created

24/24 events pass the filter

Automated ToDo Comments

3 0
Type
SWTBot Pass
SWTBot Pass
SWTBot Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass

Pass

3

Comment

which trace?? - TeamSpeak2.pcap

Automation
Candidate

Should change the action to "open a non pcap
trace" instead of "close the trace"
Bernd: Updated

Trivial test, to remove or amend?
Bernd: It's a pre-req


http://wiki.wireshark.org/SampleCaptures?action=AttachFile&do=get&target=TeamSpeak2.pcap

Section Pass Fail Automated To Do Comments
LTTng 2.0 - I/O Analysis 21 6 0 o
Target: Windows

Step Test Case Action Verification Type Comment

0 Prerequisites

Import LTTng
Kernel traces in
0.1 Import traces Tracing project
1 Project View
"Input/Output”
In the project analysis is
explorer, present and
expand a LTTng "normal" (not
1.1 Check analysis can execute Kernel trace striked-out) SWTBot Pass
In the project
explorer, open
and expand the
LTTng kernel A generic help
trace, right-click message
the Input/Output appears with
analysis and the name of the
1.2 Verify help message when applicable select Help analysis SWTBot Pass
In the project
explorer,
expand a non-  "Input/Output”
LTTng Kernel analysis is not
1.5  Check analysis for another trace type trace present SWTBot Pass
2 View Management
Open an LTTng
kernel trace and
expand the "Disk I/O
"Input/Output"  Activity" View
analysis in the  appears under
2.1 Populate analysis's view project explorer the analysis SWTBot Pass




2.2  Open view

2.3 Close trace

2.4  Open trace

2.5 Close view

2.6 Re-open view

| 3 |View selection

4  Mouse handling

4.1 Drag move time range

Double-click the
Disk 1/0 Activity
View under the
Input/Output
analysis

Close the trace
With the view
already opened,
open the trace
Close the Disk
1/0 Activity view
Double-click the
Disk I/0O Activity
view under the
Input/Output
analysis in
project explorer.

Drag move xy
chart left and
right with middle
button

The Disk I/O
Activity view
opens and
triggers the
input/output
analysis. After
the analysis, the
Xy charts is
populated.
The Disk I/O
Activity view is
emptied.

The Disk I/O
Activity view is
populated.
The view is
closed.

The view opens
and is
automatically
populated.

Time range is
dragged. When
mouse button is
released, series
are updated and
new time range
is propagated to
other views.

SWTBot

Manual

Manual

Manual

Manual

Manual



4.2

4.3

4.4

4.5

4.6

Zoom time range (mouse wheel)

Drag zoom time range

Mouse hover

Drag mouse selection

Shift key selection

Zoom with
mouse wheel up
and down,
cursor inside xy
chart

Drag select time
graph with right
button in xy
chart

Hover mouse in
Xy chart region
anywhere

Drag select xy
chart with left
button

Click select with
left button
(begin time),
press shift key
and click select
another time
(end time)

Time range is
zoomed in and
out, relative to
mouse cursor.
When mouse
wheel is
stopped for a
short time,
series are
updated and
new time range
is propagated to
other views.
Selection
highlighted.
When mouse
button is
released, time
range is
zoomed to
selection, series
are updated and
new time range
is propagated to
other views.
Tool tip shows
the puntual disk
activity, with
units in <unit>/s
Selection
highlighted and
selection range
is propagated to
other views

Selection
highlighted and
selection range
is propagated to
other views

SWTBot

Manual

Manual

Manual

Manual



4.70

4.8

5

Drag mouse selection (Status bar)

Shift key selection (Status bar)

'Keyboard handling

Drag select xy
chart with left
button

Click select with
left button
(begin time),
press shift key
and click select
another time
(end time)

Selection
highlighted.
Status bar of
Eclipse is
updated with
time
information: T,
T1, T2 and
delta, where T
is the time of
the mouse
position, T1 the
first selected
time, T2 the
second
(draggged)
selected time
and delta the
time difference
between T2-T1
(can be
negative)
Selection
highlighted.
Status bar of
Eclipse is
updated with
time
information: T,
T1, T2 and
delta, where T
is the time of
the mouse
position, T1 the
first selected
time, T2 the
second
(draggged)
selected time
and delta the
time difference
between T2-T1
(can be
negative)

Manual

Manual



6

6.1

6.2

6.3

6.4

-Synchronization

Time synchronization

Time range synchronization

Time range selection synchronisation

Disk 1/0O Activity works with experiments

Select a random
time in another
view

Select a new
time range in
Disk 1/0O Activity
view or in
Histogram view.

In any other
view that
supports range
synchronization,
select a new
range.

Selected time

line is updated.

If selected time

is outside

current range,

time range is

updated to

include it. Manual

Time range is

updated. Manual
Selection is

highlighted. If

the most left

time (T1) of

selected time

range is outside

the current

range, then time

range is

updated to

include it Manual

See bug in

comment for

acceptance

criteria. Manual

Fixed Bug 558203
https://bugs.
eclipse.
org/bugs/show_bug
.cQi?id=558203



Section
LAMI

Target: Ubuntu 20.04.4 64 bit

Step Test Case

0
0.1

0.2

1

11
1.2

21

2.2

23
24
25
26

3.1

3.3
3.4
3.5
3.6

3.7

Prerequisites
Import traces

Download analysis stubs

Custom external
analysis

Add all stubs analysis
Actions available
Actions unavailable

Delete analysis

Run analysis

Reports

Reports node

Same name report

Delete node

Open a report

Open the same report again
Multiple report

Result Table
Prerequisites
Hide table
Show table

Sorting
Colum Resizing
Multiple selection

Unselect selection

Bar Chart

Pass
0

This is deprecated, it will no longer be supported.

Action

any trace since we use stub for the result

https:/bugs.eclipse.org/bugs/attachment.cqi?id=263946

Create the following analyses ($name, $command):

analysisEmpty, analysisEmpty

analysisMultipleRow, lysisMulti ow

ar imilarRow, lysisMulti imilarRow
analysisOneRow, analysisOneRow

multipleReports, multipleReports

invalidAnalysis, invalidAnalysis

errorResult, errorResult

clone, analysisOneRow

Right click on "External Analyses" node

Click the "add" action

Insert $name

Insert "fullpath/$executable" which is the full path to the stub executable.
ex: "ftmp/stub/stubAnalysis" where stubAnalysis is the stub executable
The path does NOT support ~ or relative path

Right click on a non-strikethrough custom analysis.

Right click on a strikethrough custom analysis.

Right click on the tuple (clone, invalidAnalysis)
Select the delete action for the node

Launch remaining analysis via righ-click and run action

Expand the "Reports" node under the Project Explorer

Execute the "analysisOneRow" analysis again.

Right click on the duplicate "analysis OneRow" node and click on the
delete action

Right click on any report and select the "open" action

Right click again on the same report to open it

Open the "multipleReports" report.

Open the "analysisMultipleRowReport"
Click the "Toggle" button in the right corner of the result table
Click the "Toggle" button in the right corner of the result table

Sort all column by clicking on the column name. Clicking multiple time on
the name should change the ordering sorter.

Resize the column

Select multiple rows by holding ctrl and clicking on multiple unselected
rows of the table

Deselect multiple rows by holding ctrl and clicking on multiple selected
rows of the table

Fail

Verification

-from bug:
https://bugs.eclipse.org/bugs/show_bug.cgi?id=493941

All new external analysis are present under the "External Analysis" node in the Project explorer view.
All new elements do NOT have the strikethrough text style applied
EXCEPT for the tuple (invalidAnalysis, invalidAnalysis)

The run action can be clicked and in enabled text mode.
The run action CANNOT be clicked and is in disabled text mode.

The analysis does not appear in the list anymore.

analysisEmpty should return a message to the user regarding the emptiness of the report.
errorResult should return an error message to the user and display the result of the command.

All other one have result and should result in a new table and new report node under the report node.

The "Reports” node under the Project Explorer should contain 4 reports:
analysisMultipleRow Report

analysisMultipleSimilarRow Report

analysisOneRow Report

multipleReports

An additional node should be present under the "Reports” node:
analysisOneRow Report #2

Note: This behaviour is subject to change in the following year but still an action will be taken on same
name report creation.

The report node is not present anymore

A new panel should open with the result table of the analysis

A new panel should open with the result table of the analysis
Validate that a user is able to navigate between sub tab of a report

The result table is hidden
The result table is shown

Validate that the order make sense
Validate that the resize works
Multiple selections are highlighted in the table

The clicked row should not be selected anymore

Automated To Do Comments

Manual

Manual

Manual
Manual
Manual

Manual

Manual

Manual

Manual

Manual
Manual
Manual
Manual

Manual
Manual
Manual

Manual
Manual
Manual

Manual

To Do
To Do

To Do
To Do
To Do

To Do

To Do

To Do

To Do

To Do
To Do
To Do
To Do

To Do
To Do
To Do

To Do
To Do
To Do
To Do

16

Comment

Kyrollos: | had to open the trace to be able to see the external analysis

https://bugs.eclipse.org/bugs/show_bug.cgi?id=498218
Kyrollos: if the
trace is opened, |
had to manually
close the opened
trace and reopen it
to see that the
external analysis
that was deleted is
not in the external

https:/bugs.eclipse.org/bugs/show_bug.cgi?id=543800 analysis list

launching an analysis on a closed trace doesn't do anything

"multipleReports" is displayed "multipleReports Report" in Report

Waker and Wakee process name sorting is confusing: "Xorg" is sorted
lower than "compiz", which is sorted lower than "rcu_sched".
Kyrollos: Not sure about the Wakee process name sorting

Command key on macOS.

Command key on macOS.


https://bugs.eclipse.org/bugs/attachment.cgi?id=263946
https://bugs.eclipse.org/bugs/show_bug.cgi?id=498218
https://bugs.eclipse.org/bugs/show_bug.cgi?id=543800

41
4.2
43

4.4

4.5

4.7

4.8

4.9

4.10

5.1

52
53

5.4
55
5.6
57

Create

Series dialog add
Series dialog remove
Creat chart

Selection
Multi selection

Deselection

Y axis

Keep the chart open

Hide the table results

Scatter Chart
Create

Creat chart
Selection

Multi selection
Deselection
Mouse hovering
Full deselection

Use the menu on the upper right of the result table and select "create bar
chart"

Select any x and any y click add
Remove all newly created series via the delete button
Select any x and y and click add and "ok"

Click on any bar inside the chart
Ctrl+click on other unselected bar

Ctrl+click on other selected bar

Recreate the same graph but with the y log scale option enabled

Keep the chart open

Hide the table results

Use the menu on the upper right of the result table and select "create
scatter chart”

Select any x and y and click add and "ok"
Should be the same behaviour as the bar chart

Should be the same behaviour as the bar chart
Should be the same behaviour as the bar chart
Hover mouse in the graph

Click in the chart when no hovering cross is present

Note: a bar chart does NOT perform agregation of categories values
Series are added to the series list
User should be able to delete series

A bar chart should be created
Note: a bar chart does NOT perform agregation of categories values

The corresponding row should be selected in the table and the chart should highlight the selected bar
Selections should be highlighted in the result table and the chart

The clicked bar should be removed from selection and the result table update with the current selections

Y axis should be in log scale mode
Note: check for zero value and negative handling since log scale does not support zero and negative

A scatter chart should be created

Should be the same behaviour as the bar chart

Should be the same behaviour as the bar chart

Should be the same behaviour as the bar chart

On mouse hovering a cross should snap to the nearest point
All selected objects should be deselected
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| selected Wakee Process TID as X axis, but TID is not displayed well
because of the sheer number of TIDs.

Kyrollos: Even when the chart is exported the TIDs aren't visible

When there are too much bars inside the chart it is more difficult to click on
abar.

Kyrollos:
Sometimes it is
difficult to select an
entry from the bar
chart specially
when you have lots
of bars but | can
deselect the bars
and it worked on

https:/bugs.eclipse.org/bugs/show_bug.cgi?id=579392 Linux

When checking logarithmic scale Y, all y that do not support logarithmic

scale Y are not removed. When a Y is selected, all y that do not support

logarithmic scale Y are removed.

Marco for 7.3: don't know where to find negative or null value samples.

Kyrollos: | can't test with y negative values | don't know where to find

possible samples for such case

And? (Run the next step | presume; refactor?)

Kyrollos: What is the expected result? The chart is still open and can

create another custom views next to the chart?

Expecting what? (Toggling so the chart keeps showing | presume.)

Kyrollos: When toogle button is clicked the table is hidden and when it is

ckicked again the table appears and the chart is resized. | presume that it

is the expected output. To be confirmed

Kyrollos: When entries are selected from scatter chart, the selected entries
are selected in the table but when | toogle to hide the table and show it
again, the selected entries are no more selected in thetable

https://bugs.eclipse.org/bugs/show_bug.cgi?id=579392
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Test Case

Preparation

LTTng trace with counters

LTTng trace with no counters

Non-LTTng (no counters)

Displaying counters data

Open Counters view (after 1.1)
Populate xy-chart

Filtered checkbox tree

Re-do 2.1 + filter

Supporting experiments

Experiment with LTTng trace
with counters

Persistence between traces

Action

Import an LTTng trace with counters

(e.g. kernelVM in test traces) and open trace
Import LTTng trace with no counters, e.g
(glxgears-cyg-profile in test traces) and open

trace

Import non-LTTng trace and open trace

Double-click the Counters View under the

Counters analysis

Select several checkboxes in tree viewer

Type string in filter text box (e.g. minor)

Create experiment and add an LTTng trace

with counters

(e.g. kernelVM in test traces) to it. Open

experiment and Counters view.

Verification

In the project explorer, ensure the Counters analysis
and Counters view is available (non-strikethrough)

In the project explorer, ensure the Counters analysis
is strikethrough

In the project explorer, ensure there is no Counters
analysis

The Counters view opens and triggers the Counters
analysis. After the analysis, both tree viewer are
populated.

xy-chart populated.

Tree viewer is updated to show only entries matching
the filter string

All counters are displayed
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